
IntroductionChord	Cadenza	is	an	application	that	helps	you	to	play	along	with	a
midifile	or	audiofile.	It	allows	you	to	improvise	with	a	midi	keyboard,	even
if	you	have	only	limited	or	no	midi	keyboard	skills.
It	comes	complete	with	a	midifile	sequencer	to	play,	and	manage	midifile
tracks.	It	also	has	an	builtin	synthesizer,	and	facilities	for	generating
chords	and	keys	from	a	midifile.
The	main	functions	of	the	program	are	found	in	the	PlayMap,	TrackMap,
and	ChordMap	windows.
The	PlayMap	displays	chords	that	have	been	generated	in	a	way	that
makes	it	easy	to	play	with	a	midi	keyboard.	The	display	is	updated	as	a
midifile	(or	audiofile)	is	played.
The	TrackMap	shows	the	tracks	of	a	midifile	in	a	sequencer-type	of
display,	with	functions	for	muting,	soloing,	changing	volume,	pan,	and
midi	instrument	patches.
The	ChordMap	is	used	to	generate	and	display	chords.	You	can	also	edit
chords,	midi	time	signatures,	and	keys	from	here.
Sounds	can	be	rendered	using	the	builtin	synthesizer,	or	a	stand-alone
midi	synthesizer.
There	are	also	windows	for	calculating	keys	from	midifile	tracks,	creating
and	editing	lyrics,	and	managing	audiofile	playback	and	synchronisation.



Getting	Started

Start	the	Application
You	should	run	the	application	as	a	normal	user.
The	first	screens	you	should	see	are	the	Initial	Configuration	window
and	PlayMap	window.
You	can	reopen	the	Initial	Configuration	Window	from	the	PlayMap
Menu	>	Help	>	Show	Initial	Screen.



Initial	Configuration	Window
If	you	haven't	already	done	so,	you	should	configure	the	Midi	Keyboard
and	Midi	Ouput.	You	should	also	configure	the	Audio	Ouput	if	you	are
going	to	use	the	builtin	synthesizer	or	play	audio	files	from	here.
These	can	also	be	reconfigured	at	a	later	time	from	the	PlayMap	Menu:
PlayMap	Menu	>	Configure	>	Midi	Keyboard	Ranges.
PlayMap	Menu	>	Configure	>	Audio	Devices.
PlayMap	Menu	>	Configure	>	Midi	Devices.



Create	a	New	Project
Go	to	the	PlayMap	Window	and	click	the	New	Project	Button.
This	will	allow	you	to	copy	an	existing	MidiFile	into	a	new	Project.	If	you
haven't	got	any	MidiFiles,	you	can	download	one	from	the	internet	-	just
do	a	search	for	MidiFiles.
You	will	also	need	to	decide	where	to	put	the	project,	and	what	to	call	it.



Create	a	ChordFile
You	will	need	to	create	some	chords	in	order	to	use	the	chord	play
functions	of	this	application.
You	can	either	Generate	Chords	or	Insert	Chords
The	chords	will	be	saved	in	a	ChordFile	(*.chp)	as	part	of	the	Project.



Play	the	Chords
You	can	now	Play	the	Chords	along	with	the	MidiFile,	or	Play	a
Melody	along	with	the	MidiFile



Installation

System	Requirements
Windows	Vista	SP1,	windows	7,	8,	8.1,	10
.Net	4.0	(installed	by	default	on	Windows	8	and	later.	May	require	a
Microsoft	Update	for	Windows	Vista	SP1	and	Windows	7.	The	application
will	check	this	when	first	run.)
Audio	output	hardware	(sound	card,	speakers	or	headphones)
Access	to	some	MidiFiles.	(If	you	haven't	got	any	MidiFiles,	there	are
many	thousands	available	on	the	internet.	Just	do	a	search	for	MidiFiles.)
A	midi	keyboard	is	required,	unless	you	only	intend	to	use	the	key	and
chord	generate	functions	of	the	program.



Install
Run	the	Setup	ChordCadenza.exe	file.	If	a	previous	version	of	Chord
Cadenza	is	already	installed,	a	warning	message	will	be	displayed	before
removing	it.	The	option	to	install	the	starter	soundfont	file	should	be
checked,	unless	you	are	going	to	be	using	an	external	synthesizer	to
convert	midi	to	audio,	or	you	already	have	a	soundfont	installed.



The	Chord	File
The	ChordFile	is	a	text	file	that	contains	the	chords	that	have	been
generated	or	inserted	for	a	particular	song.	It	can	also	contain	data
relating	to	keys,	time	signatures,	and	various	other	parameters.	It	is
located	in	the	Project	path,	and	has	an	extension	of	.chp.
Chords	are	created	using	the	ChordMap,	and	can	be	saved	from	there
or	from	the	PlayMap	or	TrackMap.
The	file	can	be	edited	with	a	text	editor,	but	this	is	generally	not
recommended.
It	is	the	only	file	that	should	always	be	present	in	order	to	play	a	song
with	this	application,	unless	you	want	to	create	the	chords	from	scratch
every	time	you	intend	to	play	something!



The	Midi	File
This	is	a	standard	file	that	represents	the	musical	events	in	a	piece	of
music.	The	filename	usually	has	an	extension	of	.mid.	It	can	be	used	to
play	a	piece	of	music	on	midi	instruments.
This	program	uses	MidiFiles	to	play	a	piece	of	music,	and	to	allow	the
chords	to	be	generated	algorithmically.	A	MidiFile	is	usualy	present	in	the
Project	folder,	along	with	a	ChordFile	and	sometimes	some	other	files.
There	are	a	large	number	of	these	files	available	on	the	internet.	A
google	search	for	"midi	files"	will	return	many	sites	listing	thousands	of
MidiFiles.



The	Lyrics	File
This	is	an	optional	file	that	may	be	present	in	the	Project	folder.	It
contains	the	lyrics	of	a	song,	which	can	be	useful	when	synchronising	to
an	AudioFile.	The	filename	has	an	extension	of	.chl.
The	file	can	be	created	and	edited	using	the	Lyrics	Editor	from	the
PlayMap,	TrackMap,	or	ChordMap.
The	file	is	a	simple	text	file	that	can	also	be	edited	with	any	text	editor.



The	Audio	File
This	is	an	optional	file	that	may	be	present	in	the	Project	folder.	You	can
play	along	to	this	using	file	synchronisation	-	see	How	To	Sync	to	an
AudioFile.
The	file	can	be	in	any	of	the	following	standard	formats:

*.mp1	-	MPEG	layer	1

*.mp2	-	MPEG	layer	2

*.mp3	-	MPEG	1.0,	2.0	and	2.5	layer	3

*.wav	-	PCM	format

*.riff	-	PCM	format

*.aiff	-	Audio	interchange	File	Format

*.ogg	-	open	container	format



The	AudioSync	File
This	is	an	optional	file	that	may	be	present	in	the	Project	folder.	It	has	the
extension	.chtc.	It	is	used	during	audio	synchronisation	and	playing	-	see
How	To	Sync	to	an	AudioFile.



SoundFont	Files
SoundFont	files	are	located	in	the	SoundFont	Path.	They	have	the
extension	.sf2,	which	is	a	standard	extension	for	soundfont2	files.
This	is	used	by	the	BuiltIn	Synth	function	of	this	program.	If	you	are	not
using	this	(because	you	are	using	your	own	midi	synth),	then	there	is	no
need	to	have	these	files	present.
You	can	download	these	files	from	the	internet.	They	are	generally	free,
and	can	be	quite	large.
You	may	come	across	other	soundfont	formats	(e.g.	.sfz,	.sfArk).	These
cannot	be	used	in	this	program,	but	may	be	converted	by	a	utility.
You	can	associate	a	soundfont	with	a	midi	output	device	using	the	Midi
Devices	Configuration	Window.



The	PlayMapThe	PlayMap	is	the	first	screen	you	should	see	after	starting	the
application.
Closing	the	PlayMap	will	close	the	application.
The	top	part	of	the	PlayMap	contains	the	menu,	command	buttons,	and
various	options.
The	main	panel	below	this	shows	the	chord	notes,	spread	across	a
keyboard.	The	keyboard	can	be	configured	to	be	1	-	4	octaves	long
Resizing	the	PlayMap	window	horizontally	does	not	change	the	number
of	octaves	displayed,	but	can	be	used	to	match	the	scale	of	a	real	midi
keyboard.
You	can	also	resize	the	PlayMap	window	vertically.	This	will	allow	more
or	less	chords	to	be	displayed.	The	bottom	line	of	chords	represent	the
current	position,	with	lines	above	representing	later	chords.
The	bottom	panel	shows	the	current	major	or	minor	key	scale	notes.
The	left-hand	panel	show	bar	numbers,	and	the	right-hand	panel	shows
chord	names.
The	chord	notes	are	updated	as	a	MidiFile	(or	AudioFile)	is	played.
Each	time	a	beat	is	reached,	the	notes	move	down.



PlayMap	File	Menu

New	Project
Brings	up	a	dialog	to	create	a	new	Project.

Load	Project
Load	all	Project	files	from	the	containing	folder	that	have	the	same
qualifier	as	the	selected	file.
ChordFiles	can	have	the	qualifier	.chp0	to	.chp9	inclusively.	If	there	is
more	than	one	of	these	files	present	in	the	directory,	a	dialog	will	be
shown	to	allow	you	to	select	which	ChordFile	you	want	to	load.
You	can	also	load	a	Project	by	dragging	and	dropping	a	file	or	folder	onto
the	PlayMap,	ChordMap,	or	TrackMap.

Recent	Projects
Shows	up	to	10	recently	loaded	projects.
Select	a	project	to	load	it.

Reload	Project
Reload	the	current	project.
Can	be	useful	if	you	have	added	a	file	manually	and	want	to	reload	the
project.

Save	Project
Save	all	of	the	files	in	a	Project	to	disk.

Save	Project	As...
Save	all	of	the	files	in	a	Project	to	a	new	location	on	disk.

Save	Settings
Save	Global	Configuration	ParametersChordCadenza.ini	(the	main	config	file)



Saves	any	changes	made	to	various	global	parameters	(as	opposed	to
parameters	only	associated	with	the	current	Project).
This	involves	saving	the	following	files	in	the	application	directory:

Switch.ini	(SwitchKeys)

frmNMColors.ini	(ChordMap	colours)

frmSCColors.ini	(PlayMap	colours)

ChordCfg.ini	(Chord	generation	parameters)

Chords.Ranks.ini	(Chord	Rank	values)

Exit	Application
Terminate	the	application.
The	current	settings	will	be	saved,	unless	the	option	Prompt	to	Save
Settings	on	Exit	is	set	from	the	Miscellaneous	Configurations
Window.
Clicking	the	Close	Button	from	the	PlayMap	will	have	the	same	effect.



PlayMap	Configure	Menu

Audio	Devices
Show	Configure	Audio	Devices	Window

Midi	Devices
Show	Configure	Midi	Devices	Window

Bezier
Open	Submenu	Items:

Velocity	Bezier:

Show	Velocity	Bezier	Window

Aftertouch	Bezier:

Show	AfterTouch	Bezier	Window

SwitchKeys/Pedal
Show	SwitchKeys/Pedal	Window

Paths
Open	Submenu	Items:

Project:

Show	Project	Paths	Window

SoundFonts:

Show	SoundFonts	Paths	Window

MidiFiles:

Show	MidiFiles	Paths	Window

MidiFiles:

Show	AudioFiles	Paths	Window

Midi	Keyboard	Ranges
Show	Midi	Keyboard	Ranges	Window

Manual	Chord	Sync
Show	Man	Chord	Sync	Window

Miscellaneous



Show	Miscellaneous	Configurations	Window

Show	AudioSync	Window
Show	AudioSync	Window
You	can	use	this	to	manage	audio	sync	data.



PlayMap	Help	Menu

Contents
Show	Help	Contents	Page

Show	Initial	Screen
Show	Start-Up	Screen

About
Shows	information	about	the	program.



PlayMap	Buttons

"+"	Button
Click	to	increase	the	track	width

"-"	Button
Click	to	decrease	the	track	width

New	Project
Brings	up	a	dialog	to	create	a	new	Project.

Load	Project
Load	all	Project	files	from	the	containing	folder	that	have	the	same
qualifier	as	the	selected	file.
ChordFiles	can	have	the	qualifier	.chp0	to	.chp9	inclusively.	If	there	is
more	than	one	of	these	files	present	in	the	directory,	a	dialog	will	be
shown	to	allow	you	to	select	which	ChordFile	you	want	to	load.
You	can	also	load	a	Project	by	dragging	and	dropping	a	file	or	folder	onto
the	PlayMap,	ChordMap,	or	TrackMap.

Save	Project
Save	all	of	the	files	in	a	Project	to	disk.
Click	with	right	mouse	button	to	show	what	files	will	be	saved.

Save	Project	As...
Save	all	of	the	files	in	a	Project	to	a	new	location	on	disk.

GoTo	Start
Set	Start	Bar	to	start	of	MidiFile

Play	Midi



Play	the	MidiFile	from	Start	Bar

Play	Audio	/	Play	Audio	NoSyn
Play	the	AudioFile.
If	synchronisation	data	is	available,	the	button	will	show	Play	Audio,	and
the	the	cursor	will	move	according	to	the	synchronisation	data	in	the
AudioSync	file.
Otherwise,	the	button	will	show	Play	Audio	NoSyn.	Synchronisation	can
still	be	done	manually	using	the	Next	Beat	SwitchKey.

Sync	Audio
Play	AudioFile	and	wait	for	sync	SwitchKey

Play	&	Sync	Audio
Play	AudioFile	using	synchronisation	from	the	AudioSyncFile	until
reaching	the	SyncBar,	and	then	wait	for	the	sync	SwitchKey
This	will	allow	you	to	continue	a	partially	sync'ed	audiofile.

Stop	Play
Stop	playing	MidiFile	or	AudioFile

Pause	Play
Pause	playing	MidiFile	or	AudioFile

!	(Panic)
Panic!
Switch	off	all	midi	events
Useful	if	midi	pitch	is	continuously	sounding

Chord	Map
Show	the	ChordMap	Window..
If	no	ChordFile	has	been	loaded,	this	will	display	an	option	to	initialize	a



new	ChordFile

Track	Map
Show	the	TrackMap	Window

Audio	Sync	Config
Show	AudioSync	Window
You	can	use	this	to	manage	audio	sync	data.

Show	Summ
Show	MidiFile	summary	for	each	track.
Options	to	show	preconfigured	chord	names	and	MidiFile	time
signatures,	tempos	and	keys

Edit	Lyrics
Opens	up	a	Window	with	a	simple	text	editor	for	updating	the	Lyrics
File.
The	easiest	way	to	enter	lyrics	is	to	copy	and	paste	the	text	from	an
online	source	into	the	editor.	You	can	then	use	the	editor	window	to
match	each	bar	with	the	lyrics.
The	Lyrics	File	(*.chl)	in	the	Project	folder	can	also	be	edited	by	any	text
editor.	It	is	advisable	to	switch	on	line	numbering	to	display	bar	numbers
whilst	editing.

Note	Font
Configure	font	used	to	show	note	names	or	solfa	names

Chord	Font
Configure	font	used	to	show	chord	names

Colours
Configure	Colours	using	PlayMap	Colours	Configuration



Help
Show	help	documentation	for	this	window



PlayMap	Map
The	PlayMap	Map	is	displayed	at	the	top	of	the	PlayMap	only	if
Windows	>	Map	is	checked	on	the	PlayMap	Menu.

Track	Selection	Window

Shows	the	tracks	present	in	the	MidiFile	(if	present).
Click	to	select	or	deselect	a	track.
Multiple	selections	can	be	made	using	the	Shift	or	Control	keys.

Bar	Numbers
Shows	bar	numbers.
Any	bars	that	have	been	synchronised	to	an	audio	file	will	be	highlighted
in	yellow.

Lyrics
Shows	the	lyrics	of	the	music,	if	present.

Chord	Names
Shows	the	chord	names	in	the	music,	with	the	current	chord	highlighted
in	blue.

NoteMap
Shows	the	notes	in	the	tracks	selected	in	the	window	on	the	left.
This	will	only	be	shown	if	a	MidiFile	is	present.
This	can	be	used	to	help	locate	where	you	are	in	the	music.
Selecting	a	melodic	track	is	usually	a	good	option.



PlayMap	Check	Boxes

Scroll
Check	to	scroll	the	map	displays	whenever	the	current	position	changes.
Otherwise,	only	scroll	when	the	left	or	right	margin	has	been	reached.

Sustain
Check	to	emulate	the	Sustain	SwichKey.	This	will	also	show	the	current
status	of	the	Sustain	SwitchKey	if	assigned	to	the	keyboard	or	pedal.

KBChord
Check	to	emulate	the	KBChord	SwichKey.	This	will	also	show	the	current
status	of	the	KBChord	SwitchKey	if	assigned	to	the	keyboard	or	pedal.

ManSync	Chord	Positioning
If	checked,	the	chord	positioning	functions	can	be	used	from	the	Midi
Keyboard.
Otherwise,	unsynchronised	audio	play	can	be	achieved	using	the
NextBeat,	NextBar,	or	NextChord	SwitchKeys.

Capitalize	Root	Notes
Show	root	note	of	chord	with	caplital	letter

Auto	Capitalize	Root	Notes
Capitalize	chord	root	note	only	if	ChordMode	set

Show	Beats
Show	beats	as	dotted	lines

Show	Chord	Names
Show	chord	names	on	the	right-hand	pane



Show	Chord	Notes
Show	chord	notes	on	the	right-hand	pane

Show	Tracks
Show	notes	from	tracks	selected	on	the	TrackMap.
May	be	useful	for	playing	bass	or	melodies.
Advisable	to	select	only	one	track.

Show	Relative	Chords
If	checked,	relative	chord	names	(e.g.	I,	IIImin)	will	be	shown	in	the
Chord	Names	Panel	of	the	PlayMap.
Otherwise,	absolute	chord	names	will	be	displayed	(e.g.	C,	Emin).

Show	Chords
Show	chords	on	main	window.
Usually	checked.

Note	Display	-	Run	Notes	Across	Chords
Choose	whether	to	run	notes	across	chords	in	Keyboard	Mode.
Setting	this	means	the	note	name	is	only	displayed	when	the	note
changes.
Unsetting	it	means	that	all	note	names	are	displayed	for	every	new
chord.
It	is	recommended	to	leave	this	unset	unless	you	are	playing	chords
manually.



PlayMap	Numeric	Controls

Syncopation
Syncopation	Numerator	(NN)	and	Denominator	(DD).
Chord	played	NN/DD	notes	before	the	beat	to	allow	for	syncopation	and
keyboard	delay.
This	value	is	saved	in	the	ChordFile,	and	overrides	the	default	value
from	the	Miscellaneous	Configuration	Window

Start	Bar
Set	bar	to	start	playing	from

Beat	Height
Set	beat	height	in	pixels

Octaves
Set	number	of	octaves	to	display.
Should	match	the	number	of	playable	octaves	on	midi	keyboard,	but	may
be	limited	by	screen	width.
May	need	to	resize	PlayMap	window	after	changing	this.

Channel	Number
Midi	channel	number	to	use	for	midi	keyboard	output	(1	-	16).
If	the	Midi	Keyboard	Output	Port	is	the	same	as	the	Midi	Streaming
Port,	this	should	be	an	unused	midi	channel.
Otherwise	any	channel	should	be	OK.

Octave	Transposition:	KBPitch
Transpose	the	midi	keyboard	pitch	by	this	number	of	semitones.
Clicking	the	control	will	increment	or	decrement	the	value	by	12
semitones	(1	octave).



This	does	not	affect	where	the	currently	played	keyboard	keys	are
displayed.

Octave	Transposition:	Keyboard
Transpose	the	midi	keyboard	display	by	this	number	of	semitones.
This	does	not	affect	the	midi	pitch	that	is	actually	sounded.
Clicking	the	control	will	increment	or	decrement	the	value	by	12
semitones	(1	octave).
(This	will	change	the	position	of	the	currently	played	keyboard	key(s)	at
the	bottom	of	the	main	window.)

Octave	Transposition:	Display
Transpose	the	displayed	notes	by	this	number	of	semitones.
Clicking	the	control	will	increment	or	decrement	the	value	by	12
semitones	(1	octave).
This	will	only	have	an	affect	if	Show	Tracks	is	checked.

Semitone	Transposition:	KBPitch
Transpose	the	midi	keyboard	pitch	by	this	number	of	semitones.
Clicking	the	control	will	increment	or	decrement	the	value	by	1	semitone.
This	does	not	affect	where	the	currently	played	keyboard	keys	are
displayed.

Semitone	Transposition:	Keyboard
Transpose	the	midi	keyboard	display	by	this	number	of	semitones.
This	does	not	affect	the	midi	pitch	that	is	actually	sounded.
Clicking	the	control	will	increment	or	decrement	the	value	by	1	semitone.
(This	will	change	the	position	of	the	currently	played	keyboard	key(s)	at
the	bottom	of	the	main	window.)

Semitone	Transposition:	Stream	Pitch
Transpose	the	MidiFile	play	stream	by	this	number	of	semitones.



PlayMap	Option	Buttons

PlayMode	-	Chords	Option
Set	playmode	to	ChordMode.
Play	white	midi	keyboard	keys	assigned	to	current	chord	notes.

PlayMode	-	Keyboard	Option
Set	Playmode	to	KeyboardMode.
Play	normal	midi	keyboard	pitches,	subject	to	any	active	transposition.

NoteDisplay	-	Solfa	Option
Show	solfa	notation	(d	r	m	f	s	l	t	d)	on	main	panel.

NoteDisplay	-	Note	Name	Option
Show	actual	note	names	(C,	C#,	...	Bb,	B)	on	main	panel

NoteDisplay	-	None	Option
Don't	show	any	note	names	on	main	panel.
May	be	useful	if	you	want	to	practise	working	out	the	note	names	from
chord	names	mentally.

Sustain	Action	Option:	Replay
Emulate	sustain	by	leaving	all	chord	notes	switched	on	until	the	sustain
pedal	or	SwitchKey	is	released,	or	a	new	chord	is	played.
A	chord	is	defined	as	any	number	of	notes	played	within	the	time	interval
specified	with	the	Sustain	Numeric	Input	in	this	window.
See	Sustain	Types

Sustain	Action	Option:	Carry	Over

Same	as	Replay,	but	carries	over	any	notes	that	are	also	in	the	next



chord.
This	has	the	effect	of	making	chord	changes	smoother	for	non-
percussive	instruments.
See	Sustain	Types

Sustain	Action	Option:	Send	Sustain	Ctlr

Same	as	Replay,	but	uses	Midi	Sustain	On/Off	messages	instead	of
Midi	Note	On/Off	messages.
It	is	recommended	to	only	use	this	if	you	are	having	problems	with	the
normal	Replay.
See	Sustain	Types

Sustain	Action	Option:	Normal

Use	the	normal	Midi	Sustain	function.	This	will	send	Midi	Sustain	On/Off
messages	in	response	to	the	sustain	pedal	or	SwitchKey.
See	Sustain	Types

Sustain	Action	CheckBox:	Auto

Use	the	midi	patch	(instrument)	to	choose	the	optimal	sustain	type.

See	Sustain	Types	



PlayMap	Selection	Lists

First	Note
Sets	first	note	of	chord	to	be	displayed	on	chordname	panel.
Applies	only	if	Show	Chord	Notes	option	is	set.
May	be	useful	when	playing	chords	manually

Patch
Midi	Patch	(Program	Change)	to	use	on	the	Midi	Keyboard	Output
Channel.
This	sets	the	instrument	to	play	according	to	the	General	Midi
specification.
Set	to	blank	to	leave	it	unchanged.



PlayMap	Sliders

KBChVol
Midi	volume	level	on	Midi	Keyboard	Output	Channel

KBChPan
Midi	pan	setting	on	Midi	Keyboard	Output	Channel

Tempo
Set	the	tempo	at	which	midi	files	are	played
Midipoint	is	the	MidiFile	tempo
Values	away	from	the	midpoint	will	be	slower	or	faster	than	the	MidiFile
tempo

Tempo	"R"	Button
Reset	tempo	to	current	MidiFile	(midpoint)

AudioVol	Slider
Adjust	AudioFile	volume	level.

AudioPan	Slider
Adjust	AudioFile	panning	(balance).

KBVol	Slider
Adjust	volume	for	the	Midi	Keyboard	Output	using	the	BuiltIn
Synthesizer.

KBPan	Slider
Adjust	panning	(balance)	for	the	Midi	Keyboard	Output	using	the
BuiltIn	Synthesizer.



StreamVol	Slider
Adjust	volume	for	the	Sequencer	Stream	Output	using	the	BuiltIn
Synthesizer.

StreamPan	Slider
Adjust	panning	(balance)	for	the	Sequencer	Stream	Output	using	the
BuiltIn	Synthesizer.



PlayMap	Displays

Visible	Range
Shows	visible	pitch	range.

Track	Range
Shows	track	pitch	range.

Next	Key
Shows	next	key	after	current	position

This	Key
Shows	current	key

Bar	Number
Panel	on	the	left-hand	side	of	the	window.
Shows	Bar	Number

Chords
The	main	panel	of	the	window.
Shows	chords,	and	also	also	shows	tracks	if	the	Show	Tracks	box	is
checked.

Chord	Names
The	panel	on	the	right-hand	side	of	the	window.
It	shows	absolute	chord	names	(e.g.	C,	Amin)	or	relative	chord	names
(e.g.	I,	VImin)	depending	on	the	setting	of	Show	Relative	Chords	in	the
General	panel	of	the	Miscellaneous	Configuration	window.

Keyboard	Display
The	bottom	panel	of	the	window.



Shows	the	current	notes	that	will	be	played	by	the	midi	keyboard.



PlayMap	ColoursThis	window	can	be	used	to	set	the	colours	used	by	the	PlayMap.
You	should	try	to	set	these	colours	in	order	to	enhance	the	readability	of
the	PlayMap.	This	is	a	personal	preference,	as	everybody	has	a	different
perception	of	colours	and	contrast.
Some	of	these	colours	may	overlap	each	other,	so	be	sure	to	check	what
the	ChordMap	looks	like	after	changing	a	colour!

Configurable	Colours
The	colours	set	by	this	window	are:

Main	Background:

The	main	background	colour.

Black	Key:

Colour	representing	a	black	key	on	the	midi	keyboard.

Chord	Note:

Fill	colour	for	a	note	that	is	part	of	the	chord.

Root	Note:

Fill	colour	for	the	root	note	of	the	chord.

This	is	only	used	if	Capitalize	Root	Notes	option	is	set.

Dominant	Note:

Fill	colour	for	the	dominant	note	of	the	chord.

This	is	only	used	if	Capitalize	Root	Notes	option	is	set.

Note:

Note	text	(Solfa	or	Pitch)	colour.

Track	Note:

Fill	colour	for	a	track	note	(as	opposed	to	chord	note).

Bottom	Background:

Background	colour	of	bottom	row	(scale	notes).

Played	Note:

Colour	of	filled	circle	showing	currently	played	note	or	notes.



Current	Background:

Background	colour	of	current	note	row.

Scale:

Scale	text	colour	(bottom	row).



The	TrackMapThe	TrackMap	is	the	main	window	for	managing	and	playing	midi	tracks.
It	shows	the	notes	for	each	track	of	the	MidiFile.
It	allows	you	to	select	tracks	for	generating	chords,	mute	and	solo	tracks,
and	change	the	volume,	panning,	and	patch	(instrument)	for	each	track.
You	can	also	display	the	lyrics	with	this.
By	default,	all	tracks	from	the	MidiFile	are	shown,	but	you	can	click	the
Track	Styles	Button	to	bring	up	a	window	to	manage	which	tracks	are
visible.



TrackMap	Buttons

New	Project
Brings	up	a	dialog	to	create	a	new	Project.

Load	Project
Load	all	Project	files	from	the	containing	folder	that	have	the	same
qualifier	as	the	selected	file.
ChordFiles	can	have	the	qualifier	.chp0	to	.chp9	inclusively.	If	there	is
more	than	one	of	these	files	present	in	the	directory,	a	dialog	will	be
shown	to	allow	you	to	select	which	ChordFile	you	want	to	load.
You	can	also	load	a	Project	by	dragging	and	dropping	a	file	or	folder	onto
the	PlayMap,	ChordMap,	or	TrackMap.

Save	Project
Save	all	of	the	files	in	a	Project	to	disk.
Click	with	right	mouse	button	to	show	what	files	will	be	saved.

Save	Project	As...
Save	all	of	the	files	in	a	Project	to	a	new	location	on	disk.

GoTo	Start
Set	Start	Bar	to	start	of	MidiFile

Play	Midi
Play	the	MidiFile	from	Start	Bar

Play	Audio	/	Play	Audio	NoSyn
Play	the	AudioFile.
If	synchronisation	data	is	available,	the	button	will	show	Play	Audio,	and
the	the	cursor	will	move	according	to	the	synchronisation	data	in	the



AudioSync	file.
Otherwise,	the	button	will	show	Play	Audio	NoSyn.	Synchronisation	can
still	be	done	manually	using	the	Next	Beat	SwitchKey.

Sync	Audio
Play	AudioFile	and	wait	for	sync	SwitchKey

Play	&	Sync	Audio
Play	AudioFile	using	synchronisation	from	the	AudioSyncFile	until
reaching	the	SyncBar,	and	then	wait	for	the	sync	SwitchKey
This	will	allow	you	to	continue	a	partially	sync'ed	audiofile.

Stop	Play
Stop	playing	MidiFile	or	AudioFile

Pause	Play
Pause	playing	MidiFile	or	AudioFile

!	(Panic)
Panic!
Switch	off	all	midi	events
Useful	if	midi	pitch	is	continuously	sounding

Chord	Map
Show	the	ChordMap	Window..
If	no	ChordFile	has	been	loaded,	this	will	display	an	option	to	initialize	a
new	ChordFile

Audio	Sync	Config
Show	AudioSync	Window
You	can	use	this	to	manage	audio	sync	data.



Show	Summ
Show	MidiFile	summary	for	each	track.
Options	to	show	preconfigured	chord	names	and	MidiFile	time
signatures,	tempos	and	keys

Edit	Lyrics
Opens	up	a	Window	with	a	simple	text	editor	for	updating	the	Lyrics
File.
The	easiest	way	to	enter	lyrics	is	to	copy	and	paste	the	text	from	an
online	source	into	the	editor.	You	can	then	use	the	editor	window	to
match	each	bar	with	the	lyrics.
The	Lyrics	File	(*.chl)	in	the	Project	folder	can	also	be	edited	by	any	text
editor.	It	is	advisable	to	switch	on	line	numbering	to	display	bar	numbers
whilst	editing.

Check	All
Click	to	Select	all	tracks.
Tracks	can	be	unselected	individually	in	the	main	display.
Selected	tracks	are	used	when	the	ChordMap	is	loaded.
They	are	also	the	tracks	that	will	be	shown	in	the	PlayMap	if	the	Show
Tracks	CheckBox	is	checked	in	the	PlayMap.

Uncheck	All
Click	to	Deselect	all	tracks.
Tracks	can	be	selected	individually	in	the	main	display.
Selected	tracks	are	used	when	the	ChordMap	is	loaded.
They	are	also	the	tracks	that	will	be	shown	in	the	PlayMap	if	the	Show
Tracks	CheckBox	is	checked	in	the	PlayMap.

Clear	Mutes	&	Solos
Clear	the	Mute	and	Solo	CheckBoxes	on	all	tracks



Track	Styles
Displays	a	window	to	allow	groups	of	tracks	to	be	selected,	muted,
hidden,	or	collapsed.
The	tracks	are	grouped	by	Style.

Calc	Keys
Open	the	CalcKeys	Window.
This	will	allow	you	to	generate	keys	from	the	MidiFile	or	ChordFile.
A	dialog	will	be	shown	if	there	are	multiple	choices	of	where	to	generate
the	keys	from.

Save	MidiFile	As...
Save	the	MidiFile	at	a	given	location	with	a	given	filename.
Displays	the	Save	MidiFile	Dialog	to	allow	various	options	to	be	set
before	saving	the	MidiFile.

"+"	Button	in	Vertical	Group
Click	to	increase	the	track	height

"-"	Button	in	Vertical	Group
Click	to	decrease	the	track	height

"+"	Button	in	Horizontal	Group
Click	to	increase	the	track	width

"-"	Button	in	Horizontal	Group
Click	to	decrease	the	track	width

[Up	Arrow]	Button
Collapse	(hide)	all	tracks.

[Down	Arrow]	Button



Uncollapse	(show)	all	tracks.

"Pan"
Click	to	set	track	controls	to	adjust	midi	pan	(balance)	value

"Vol"
Click	to	set	track	controls	to	adjust	midi	volume	value

"+"	Button	to	Right	of	Vol/Pan	Buttons
Click	to	increase	midi	pan	or	volume	on	all	selected	tracks

"-"	Button	to	Right	of	Vol/Pan	Buttons
Click	to	decrease	midi	pan	or	volume	on	all	selected	tracks



TrackMap	CheckBoxes
Lyrics
Display	Lyrics	Panel,	using	data	from	the	LyricsFile.
Similar	to	the	Lyrics	Panel	in	the	ChordMap.,	but	not	editable.

Even	Trk	Spacing
If	checked,	each	track	will	be	about	the	same	height,	but	the	pitch	scale
will	vary.
If	unchecked,	the	pitch	scale	will	be	constant,	but	the	track	height	will
vary.
Changing	this	will	reset	the	scale	to	its	default	value.

Show	Beats
Check	to	display	beat	lines	as	well	as	bar	lines	for	each	track.

Show	KB
Check	to	show	midi	keyboard	black	notes	(default	colour	grey)	for	each
track.

Show	One	Octave
If	checked,	will	show	notes	condensed	into	one	octave.	This	can	make	it
easier	to	recognise	chords.
Otherwise,	actual	pitches	will	be	shown	over	whatever	range	each	track
uses.



TrackMap	Displays
Ticks
Shows	the	midi	ticks	for	the	current	bar	(when	clicked	with	the	mouse).

Lyrics
(Only	displayed	if	LyricsFile	is	present.)
Show	Lyrics,	using	data	from	the	LyricsFile.



TrackMap	TracksEach	track	of	the	TrackMap	contains	a	Control	Panel	and	a	Display
Panel.



The	Control	Panel
This	shows	basic	information	about	the	track,	and	also	allows	various
properties	to	be	changed.
It	contains	these	controls:



Top	Row

Up	or	Down	Arrow
Collapse	the	track.

Track	Description
Displays	the	Midi	Track	Description	or	Title.
If	this	is	updated,	it	will	be	saved	in	the	MidiFile.

Style	Display
Displays	the	Track	Style



Middle	Row

Channel	Number	Display
Show	the	midi	channel	number	(C1	-	C16).

Instrument	Name
List	for	displaying	and	selecting	the	General	Midi	Instrument.



BottomRow

Check	Box
CheckBox	for	selecting	the	track.
Selected	tracks	are	used	when	the	ChordMap	is	loaded.
They	are	also	the	tracks	that	will	be	shown	in	the	PlayMap	if	the	Show
Tracks	CheckBox	is	checked	in	the	PlayMap.

'M'	Button
Mute	the	track.
Colour	changes	from	grey	to	red	when	muted.

'S'	Button
Solo	the	track.
Mute	all	tracks	except	any	that	are	solo'ed.
Colour	changes	from	grey	to	blue	when	solo'ed.

Track	Number	Display
Shows	the	Midi	Track	Number	preceded	by	'T'.
If	the	track	contains	pitchbent	notes,	the	text	will	be	surrounded	by	a
border.

Slider
Adjust	Midi	Volume	or	Pan	level.
Use	Pan	and	Vol	buttons	on	main	display	to	select	whether	volume	or
pan	level	is	adjusted.



The	Trk	Panel
This	is	where	the	track	notes	are	displayed.
Notes	are	displayed	with	the	lowest	'C'	at	the	bottom.
Any	pitches	that	have	had	midi	pitchbend	applied	are	shown	in	blue.



The	ChordMapThe	ChordMap	is	used	to	generate	chords	from	the	MidiFile,	which	is
then	saved	to	the	ChordFile.	A	general	guide	to	generating	chords	can
be	found	here.
The	ChordMap	can	also	be	used	to	Insert	Chords	from	an	External
Source..
The	top	part	of	the	ChordMap	window	consists	of	various	buttons	and
options	for	creating	the	chords	and	playing	the	song.
Below	this	are	various	display	windows	-	see	ChordMap	Display
Windows.
The	colours	used	by	this	window	can	be	set	with	the	ChordMap	Colours
Configuration	Window.
The	Transpose	Chord	Names	and	Transpose	Chord	Notes	Controls
allow	you	to	enter	transposed	chord	names	and	keys.	This	is	useful	for
typing	in	chord	names	from	an	external	source	that	are	in	a	different	key
to	the	MidiFile	or	AudioFile.



ChordMap	Buttons
New	Project
Brings	up	a	dialog	to	create	a	new	Project.

Load	Project
Load	all	Project	files	from	the	containing	folder	that	have	the	same
qualifier	as	the	selected	file.
ChordFiles	can	have	the	qualifier	.chp0	to	.chp9	inclusively.	If	there	is
more	than	one	of	these	files	present	in	the	directory,	a	dialog	will	be
shown	to	allow	you	to	select	which	ChordFile	you	want	to	load.
You	can	also	load	a	Project	by	dragging	and	dropping	a	file	or	folder	onto
the	PlayMap,	ChordMap,	or	TrackMap.

Save	Project
Save	all	of	the	files	in	a	Project	to	disk.
Click	with	right	mouse	button	to	show	what	files	will	be	saved.

Save	Project	As...
Save	all	of	the	files	in	a	Project	to	a	new	location	on	disk.

GoTo	Start
Set	Start	Bar	to	start	of	MidiFile

Play	Midi
Play	the	MidiFile	from	Start	Bar

Play	Audio	/	Play	Audio	NoSyn
Play	the	AudioFile.
If	synchronisation	data	is	available,	the	button	will	show	Play	Audio,	and
the	the	cursor	will	move	according	to	the	synchronisation	data	in	the
AudioSync	file.
Otherwise,	the	button	will	show	Play	Audio	NoSyn.	Synchronisation	can
still	be	done	manually	using	the	Next	Beat	SwitchKey.



Sync	Audio
Play	AudioFile	and	wait	for	sync	SwitchKey

Play	&	Sync	Audio
Play	AudioFile	using	synchronisation	from	the	AudioSyncFile	until
reaching	the	SyncBar,	and	then	wait	for	the	sync	SwitchKey
This	will	allow	you	to	continue	a	partially	sync'ed	audiofile.

Stop	Play
Stop	playing	MidiFile	or	AudioFile

Pause	Play
Pause	playing	MidiFile	or	AudioFile

!	(Panic)
Panic!
Switch	off	all	midi	events
Useful	if	midi	pitch	is	continuously	sounding

Track	Map
Show	the	TrackMap	Window

Audio	Sync	Config
Show	AudioSync	Window
You	can	use	this	to	manage	audio	sync	data.

Show	Summ
Show	MidiFile	summary	for	each	track.
Options	to	show	preconfigured	chord	names	and	MidiFile	time
signatures,	tempos	and	keys

Edit	Lyrics



Opens	up	a	Window	with	a	simple	text	editor	for	updating	the	Lyrics
File.
The	easiest	way	to	enter	lyrics	is	to	copy	and	paste	the	text	from	an
online	source	into	the	editor.	You	can	then	use	the	editor	window	to
match	each	bar	with	the	lyrics.
The	Lyrics	File	(*.chl)	in	the	Project	folder	can	also	be	edited	by	any	text
editor.	It	is	advisable	to	switch	on	line	numbering	to	display	bar	numbers
whilst	editing.

Save	Chords	As...
Opens	a	Dialog	to	save	the	ChordFile	with	a	filename	extension	chosen
from	a	list.

Reload	Midi	Tracks
Reload	the	MidiFile,	using	selected	tracks	from	the	TrackMap.
May	be	useful	if	you	want	to	use	a	different	selection	of	tracks	to
generate	the	chords	from.

Select	All
Set	the	selected	area	to	the	whole	song.
This	is	used	for	generating	chords,	and	by	Insert	Bars,	Delete	Bars,
Cut,	Copy,	Paste,	and	Paste	Special.

Select	None
Set	the	selected	area	to	nothing.
If	Generate	Chords	is	clicked,	this	will	cover	the	whole	song.

Insert	Bars
Insert	empty	bars	at	the	current	cursor.
The	number	of	bars	will	be	the	same	as	the	number	of	bars	in	the
selected	area
This	will	only	affect	the	chords	-	not	the	MidiFile	or	Lyrics.



All	chords	after	the	selected	area	will	be	moved	to	the	right.
Notes	in	the	MidiFile	will	remain	the	same,	but	the	time	signatures	may
change.
Caution:	Any	chords	that	run	off	the	end	will	be	removed!

Delete	Bars
Delete	bars	in	the	selected	area.
All	chords	after	the	selected	area	will	be	moved	to	the	left.
Notes	in	the	MidiFile	will	remain	the	same,	but	the	time	signatures	may
change.

Cut
Copy	chords,	keys,	and	time	signatures	from	the	selected	area	to	the
Copy	Buffer,	and	clear	chords	from	the	selected	area.
Shortcut	key	is	Ctrl/X.

Copy
Copy	chords,	keys,	and	time	signatures	from	the	selected	area	to	the
Copy	Buffer.
Shortcut	key	is	Ctrl/C.

Paste
This	will	open	up	a	new	window	with	options	for	pasting	data	from	the
Copy	Buffer.
Shortcut	key	is	Ctrl/V.

Trans	Select
This	will	transpose	all	the	chords	in	the	selected	area	by	the	interval
entered	in	the	accompanying	dialog.

Undo
Undo	last	change.



Shortcut	key	is	Ctrl/Z.
This	will	undo	any	changes	to	the	chords,	keys,	time	signatures,	or	song
length.

Redo
Redo	last	undone	change.
Shortcut	key	is	Ctrl/Y.
This	will	redo	any	changes	to	the	chords,	keys,	time	signatures,	or	song
length.

Play	Midi	This
Play	the	MidiFile	using	the	tracks	in	the	ChordMap

Colours
Open	the	ChordMap	Colours	Configuration	Window.

Calc	Keys
Open	the	CalcKeys	Window.
This	will	allow	you	to	generate	keys	from	the	MidiFile	or	ChordFile.
A	dialog	will	be	shown	if	there	are	multiple	choices	of	where	to	generate
the	keys	from.

Generate	Chords
Generate	chords	using	the	current	Chord	Div	settings	(Bar,	Bar/2,	Beat,
or	Auto).
This	will	create	new	chords	in	the	Chord	Notes	panel,	based	on	the
minimum	time	interval	selected	with	the	Chord	Div	option.

"+"	Button	in	Horizontal	Group
Click	to	increase	the	track	width

"-"	Button	in	Horizontal	Group



Click	to	decrease	the	track	width

"+"	Button	in	Vertical	Group
Click	to	increase	the	track	height

"-"	Button	in	Vertical	Group
Click	to	decrease	the	track	height



ChordMap	Displays
Desc
Shows	the	ChordFile	Description.
This	can	be	updated	here,	and	will	be	saved	with	the	ChordFile.

Bar
Shows	bar	numbers.	MouseClick	can	be	used	when	synchronising	to	an
AudioFile	to	set	the	sync	position	-	see	help	topic:	How	To	Sync	to	an
AudioFile.
Any	bars	that	have	been	synchronised	to	an	audio	file	will	be	highlighted
in	yellow.

Margin
Set	scroll	margins.
Click	the	mouse	to	set	regions	where	scrolling	is	forced	by	the	current
cursor.

Lyrics
(Only	displayed	if	LyricsFile	is	present.)
Show	Lyrics,	using	data	from	the	LyricsFile.

Chord	Names
This	allows	the	chordnames	to	be	displayed	and	updated.
Type	in	a	chordname	(e.g.	C,	Am,	Fdim)	and	press	enter	to	update.
Chord	notes	will	also	be	updated	in	the	Chord	Notes	panel.

Key	(Names)
Shows	and	updates	the	midi	keys,	as	applied	to	the	Chord	Names	pane.
(Click	to	display	update	menu.)
See	HowTo	Update	Keys.

Midi



This	shows	the	MidiFile	notes	from	tracks	selected	in	the	TrackMap.
Click	with	any	Mouse	Button	to	set	the	current	cursor	position.
Shift/Click	with	the	left	mouse	button	to	set	the	start	of	the	selected	area.
Shift/Right	click	to	set	the	end	of	the	selected	area.
The	selected	area	will	always	be	aligned	to	a	bar.

Chords
This	shows	the	ChordFile	notes.
Click	with	the	Left	Mouse	Button	to	set	the	current	cursor	position.
Right	click	in	the	main	body	of	the	window	to	insert	or	delete	chord	notes.
Shift/Click	with	the	left	mouse	button	to	set	the	start	of	the	selected	area.
Shift/Right	click	to	set	the	end	of	the	selected	area.
The	selected	area	will	always	be	aligned	to	a	bar.
You	can	use	the	Snap	To	DropDownList	to	control	the	duration	of	the
deleted	or	inserted	note.
The	colours	of	the	notes	can	be	set	with	the	ChordMap	Colours
Configuration	Window.

Key	(Notes)
Shows	and	updates	the	midi	keys,	as	applied	to	the	Chord	Notes	pane.
(Click	to	display	update	menu.)
See	HowTo	Update	Keys.

TSig
Shows	and	updates	the	midi	time	signatures.	(Click	to	display	update
menu.)
See	HowTo	Update	Time	Signatures.
You	can	also	change	the	song	length	from	here	when	there	is	no	MidiFile
loaded.

Scroll



Horizontal	scroll	bar.



ChordMap	Miscellaneous	Controls
Snap	To	DropDownList
Set	Snap	To	interval.	This	can	be	Notes,	Selected,	Bar,	HalfBar,	or	Beat).
Controls	what	to	snap	to	when	inserting	or	deleting	pitches	in	the	Chords
Panel.

Show	Beats	CheckBox
Show	beat	lines	as	well	as	bar	lines.

One	Octave	CheckBox
If	checked,	displays	Midi	Window	reduced	to	one	octave.	Else	displays
actual	note	pitches.

Show	Keyboard	CheckBox
Show	black	notes	of	the	midi	keyboard	(default	colour	grey)	in	Midi
Panel	and	Chords	Panel.

Transpose	Display:	Chord	Names	Numeric	Input
Transpose	the	Chord	Names	pane,	but	not	the	Chord	Notes	pane,	by
this	number	of	semitones.
This	will	allow	you	to	type	in	chord	names	in	the	Chord	Names	pane	that
are	a	transposition	of	the	notes	in	the	ChordNotes	pane.
When	the	chordfile	is	saved,	it	will	use	the	notes	in	the	Chord	Notes
pane,	and	adjust	the	chord	names	if	necessary.

Transpose	Notes:	Chord	Notes	'+'/'-'	Commands
Transpose	the	Chord	Notes	pane,	but	not	the	Chord	Names	pane,	up	or
down.
This	will	allow	you	to	change	the	notes	in	the	Chord	Notes	pane,	whilst
keeping	the	names	of	the	chords	in	the	Chord	Names	pane	the	same.
When	the	chordfile	is	saved,	it	will	use	the	notes	in	the	Chord	Notes
pane,	and	adjust	the	chord	names	if	necessary.



Transpose	Notes:	Keys	'+'/'-'	Commands
Transpose	all	keys	in	the	ChordMap	up	or	down.
The	key	chosen	will	have	the	minimum	number	of	sharps	or	flats	in	the
key	signature.

Transpose	Notes:	Chord	Notes	and	Keys	'+'/'-'	Commands
Transpose	the	Chord	Notes	pane,	but	not	the	Chord	Names	pane,	up	or
down.
This	will	allow	you	to	change	the	notes	and	keys	in	the	Chord	Notes
pane,	whilst	keeping	the	names	of	the	chords	in	the	Chord	Names	pane
the	same.
When	the	chordfile	is	saved,	it	will	use	the	notes	and	keys	in	the	Chord
Notes	pane,	and	adjust	the	chord	names	if	necessary.

Chord	Div	Options	(Bar,	Bar/2,	Beat,	Auto)
Set	the	Chord	Div	value.	This	is	used	when	generating	chords	to
determine	the	time	value	to	generate	chords	into.
A	setting	of	Auto	will	analyse	the	chords	and	decide	on	an	optimum
value	dynamically.



ChordMap	ColoursThis	window	can	be	used	to	set	the	colours	used	by	the	Chords	Panel
on	the	ChordMap.

Configurable	Colours
The	colours	set	by	this	window	are:

Background:

The	main	background	colour.

This	may	be	combined	with	the	colour	of	the	Selected	Area.

Play	Cursor:

The	colour	of	the	vertical	line	representing	the	current	play	cursor.

Selected	Area:

The	colour	of	the	selected	area.

This	may	be	combined	with	the	Background	Colour.

Keyboard:

The	colour	of	the	black	keys	on	the	midi	keynoard.

Common	Chord:

Chord	is	of	rank	1	or	2	according	to	the	chords	database	(Chords.ini	file).

Other	Controls

Load	Default	Values
Reset	colours	back	to	values	set	during	program	installation.

Close
Close	this	window



Audio	Configuration	WindowThis	is	used	to	configure	the	application's	audio	device.
It	only	needs	to	be	configured	if	you	are	going	to	use	the	BuiltIn	Synth	or
Play	AudioFile	functions	of	this	program.	All	audio	output	is	mixed	down
to	one	stereo	channel,	which	is	output	to	whatever	audio	device	has	been
configured.
The	top	line	Shows	the	current	connection,	if	there	is	one.
Below	that,	there	is	a	dropdown	list	showing	available	soundcard	drivers
on	your	system.	You	should	select	whatever	device	you	intend	to	use,
after	clicking	the	Disconnect	Audio	&	BuiltIn	MidiOut	Button	if
necessary.
The	CheckBox	below	that	is	to	set	ASIO	on	or	off.	ASIO	is	a	sound	card
driver	specified	by	Steinberg	Media	Technologies	GmbH.	It	is	generally
supported	on	high-end	sound	cards,	and	provides	low	latency.	This	is
important	for	real	time	music	applications	like	this,	as	you	generally	want
to	minimize	any	delays	between	playing	a	note	and	actually	hearing	it.	If
you	are	only	going	to	use	the	soundcard	for	playing	audio	files,	it	doesn't
really	matter	if	you	use	ASIO	or	not.
If	your	soundcard	does	not	support	ASIO,	you	should	leave	the	box
unchecked,	or	download	an	ASIO	driver.	ASIO4All	by	Michael	Tippach	is
an	excellent	driver	that	appears	to	work	with	most	soundcards.
The	general	idea	is	that	you	should	minimize	the	latency,	but	without
distorting	the	sound	output.	If	the	latency	is	too	low,	you	will	get	sound
dropouts	or	no	sound	at	all.	If	the	latency	is	too	high,	there	will	be	a
discernable	delay	between	playing	a	note	on	the	midi	keyboard,	and
actually	hearing	it.
Audio	settings	can	be	changed	only	when	the	soundcard	is	disconnected
using	the	Disconnect	Audio	&	BuiltIn	MidiOut	Button.

Configuring	ASIO	Drivers
If	the	ASIO	CheckBox	is	checked,	you	should	see	a	list	of	ASIO	devices
in	the	Audio	Output	DropdownBox.	Select	the	device	that	you	want	to
output	to.
Clicking	the	ASIO	Panel	Button	should	show	the	ASIO	control	panel
from	the	ASIO	driver.	If	the	device	is	not	connected,	you	should	be	able



to	adjust	the	settings	on	the	ASIO	panel	and	reconnect.

You	should	try	to	find	the	lowest	latency	time	that	does	not	cause
distortion	of	the	sound.	Any	settings	will	be	saved	with	all	of	the	other
settings	in	the	ChordCadenza.ini	file.

Configuring	Non-ASIO	Drivers
If	the	ASIO	CheckBox	is	unchecked,	you	should	see	a	list	of	non-ASIO
devices	in	the	Audio	Output	DropdownBox.	Select	the	device	that	you
want	to	output	to.
There	should	be	a	panel	in	the	bottom	left	quadrant	of	the	window
showing	Device	Characteristics	and	Device	Variables.
The	Device	Characteristics	panel	shows	the	latency	and	minimum
buffer	size,	as	reported	from	the	sound	card	selected	in	the	Audio
Output	DropdownBox.	If	you	update	the	Set	Device	Variable	fields,
and	click	one	of	the	Connect	Buttons,	this	will	activate	the	sound	card
with	the	new	settings.	You	should	be	able	to	try	out	the	audio	card
(assuming	you	have	set	a	midi	port	to	BuiltIn	Synth	on	the	Midi	Devices
Configuration	Window).
Adjusting	these	parameters	is	somewhat	hit	and	miss.	If	the	sound	is
distorted	or	silent,	you	should	increase	the	Buffer	Size.	If	you	are
experiencing	high	latency	(delay	between	playing	a	pitch	and	hearing	it),
you	can	try	decreasing	the	Buffer	Size.	The	smaller	the	buffer	is,	the
shorter	the	Update	Period	should	be.
Once	you	have	found	some	values	that	work,	don't	forget	to	save	the
settings	using	PlayMap	Menu	>	File	>	Save	Settings,	or	click	Save
Settings	and	Exit	Program	option	when	exiting	the	application.



Audio	Configuration	Components

Current	Connection	Display
Shows	the	audio	device	that	is	currently	connected.
This	will	be	used	by	any	midi	output	ports	set	to	BuiltIn	Synth,	and	by
the	AudioFile	player.
It	may	or	may	not	be	the	same	as	the	selected	device	in	the	dropdown
box.

Audio	Output	Selection
Selected	audio	output	device.
Use	this	to	select	a	new	device.	You	may	need	to	click	the	Disconnect
Button	before	selecting	a	new	device.
When	selected,	the	Device	Characteristics	fields	should	be	updated.
Click	the	Connect	Button	to	make	the	device	the	current	connection.

Asio	CheckBox
Use	ASIO	driver.
Check	if	you	have	an	ASIO	soundcard	or	third	party	driver.

ASIO	Panel	Button
Show	ASIO	Control	Panel	(as	supplied	by	the	ASIO	driver)

Connect	Audio	Only	Button
Connect	the	audio	device	selected	on	the	Audio	Output	DropdownList.
If	you	want	to	use	any	BuiltIn	Synthesizer	Midi	ports,	these	will	need	to
be	connected	using	the	Midi	Devices	Configuration	Window.
Alternatively,	you	can	click	the	Connect	Audio	&	BuiltIn	MidiOut	Button
to	connect	any	BuiltIn	Synthesizer	Midi	ports.

Connect	Audio	&	BuiltIn	MidiOut	Button



Connect	the	audio	device	selected	on	the	Audio	Output	DropdownList.
This	will	also	connect	any	BuiltIn	Synthesizer	Midi	ports.

Disconnect	Audio	&	BuiltIn	MidiOut	Button
Disconnect	the	audio	device	selected	in	the	Audio	Output
DropdownList.
You	may	need	to	click	this	before	selecting	a	new	device.
This	may	be	useful	if	you	want	to	start	another	audio	application	that
needs	exclusive	access	to	a	soundcard.
This	will	also	disconnect	any	BuiltIn	Synthesizer	Midi	ports.

Latency	Display
Shows	the	delay	(in	milliseconds)	between	sending	an	audio	signal,	and
hearing	it,	as	estimated	from	the	soundcard.

Min	Buffer	Display
Shows	the	minimum	buffer	size	(in	milliseconds)	required,	as	reported
from	the	soundcard.

Buffer	Size	Numeric	Control
Set	the	Buffer	Size	(in	milliseconds)	that	will	be	used	when	the	soundcard
is	connected.
Decreasing	this	should	decrease	the	latency,	but	with	the	risk	of	sound
distortion	or	drop-outs.
Values	should	be	in	the	range	11	to	5000	milliseconds.

Update	Period	Numeric	Control
Set	the	Update	Period	in	milliseconds.
This	will	be	sent	to	the	soundcard	when	connected.
You	may	need	to	lower	this	to	support	a	smaller	buffer	size,	but	this	will
use	more	CPU.
Values	should	be	in	the	range	5	to	100	milliseconds.



Calc	From	Update	Period	Button
Calculate	the	Buffer	Size	from	the	Update	Period.
This	is	done	using	a	simple	formula	to	calculate	a	minmum	buffersize,
using	the	device's	Min	Buffer	setting.
It	is	not	guaranteed	to	give	a	satisfactory	result,	but	can	act	as	a	starting
point	for	further	experimentation.

MidiPlay	Delay	Numeric	Control
Set	a	delay	(in	milliseconds)	before	updating	the	play	cursor	whilst
playing	a	midifile.
This	can	be	useful	if	the	audio	driver	has	a	significant	latency.
The	default	is	zero,	meaning	the	play	cursor	will	be	updated	as	soon	as
the	bar	or	beat	in	the	midifile	is	reached.
Any	changes	have	immediate	effect	-	there	is	no	need	to	reconnect	the
device.

Keyboard	Delay	Numeric	Control
Set	the	delay	before	moving	on	to	the	next	chord	in	the	ChordMap.
This	will	be	added	to	the	syncopation	time,	which	is	set	from	the
PlayMap.
Any	changes	have	immediate	effect	-	there	is	no	need	to	reconnect	the
device.

Set	From	Device	(MidiPlay	Delay)	Button
Set	the	MidiPlay	Delay	to	the	latency	from	the	audio	device	driver.
If	the	latency	is	low	(less	than	50	ms),	it	is	not	normally	necessary	to	set
this.

Switch	Off	(MidiPlay	Delay)	Button
Set	the	MidiPlay	Delay	to	zero.

Set	From	Device	(Keyboard	Delay)	Button



Set	the	Midi	Keyboard	Delay	to	the	latency	from	the	audio	device	driver.
If	the	latency	is	low	(less	than	50	ms),	it	is	not	normally	necessary	to	set
this.

Switch	Off	(Keyboard	Delay)	Button
Set	the	Midi	Keyboard	Delay	to	zero.

Help
Show	help	documentation	for	this	window

Close
Close	this	window



Manual	Chord	Synchronisation	WindowThis	is	used	to	configure	the	parameters	used	when	playing	along	with
an	unsynchronised	audio	source	using	chord	positioning.	It	is	typically
used	when	playing	along	with	an	internet	stream	or	other	musicians.	It
can	also	be	used	to	play	along	with	an	audio	file	(.mp3),	whether	it	is
synchronised	or	not.
The	window	is	displayed	by	selecting	Configure	>	Manual	Chord	Sync
from	the	PlayMap.
A	summary	of	the	techniques	available	to	play	along	with	live	audio,
including	chord	positioning,	can	be	found	here.



Manual	Chord	Synchronisation	Components
Single	Black	key	-	No	Action	Option
Take	no	action	when	a	single	black	key	is	played.

Single	Black	key	-	Next	chord	Option
Move	the	current	position	forward	by	one	chord	when	a	single	black	key
is	played.
The	position	is	moved	when	the	midi	key	is	released.

Single	Black	key	-	Previous	chord	Option
Move	the	current	position	backward	by	one	chord	when	a	single	black
key	is	played.
The	position	is	moved	when	the	midi	key	is	released.

Single	White	key	-	No	Action	Option
Take	no	action	when	a	single	white	key	is	played.

Single	White	key	-	Next	chord	Option
Move	the	current	position	forward	by	one	chord	when	a	single	white	key
is	played.
The	position	is	moved	when	the	midi	key	is	released.

Single	White	key	-	Previous	chord	Option
Move	the	current	position	backward	by	one	chord	when	a	single	white
key	is	played.
The	position	is	moved	when	the	midi	key	is	released.

Next	Chord	if	All	Black	Checkbox
If	checked,	move	the	current	position	forward	by	one	chord	if	2	or	more
black	notes	are	played	on	the	keyboard.
The	position	is	moved	when	the	2nd.	midi	key	is	played.

Next	Chord	if	All	White	Checkbox



If	checked,	move	the	current	position	forward	by	one	chord	if	2	or	more
white	notes	are	played	on	the	keyboard.
The	position	is	moved	when	the	2nd.	midi	key	is	played.

Help	Button
Show	help	documentation	for	this	window

Close	Button
Close	this	window



Midi	Devices	ConfigurationThis	is	used	to	configure	the	midi	devices	(ports)	used	by	this	application.
There	are	three	devices	that	can	be	configured	here:
Midi	Keyboard	Output

The	Midi	Keyboard	Input	should	be	set	to	your	midi	keyboard
The	output	devices	can	be	set	to	a	midi	synthesizer	that	is	external	to	this
application,	or	to	the	BuiltIn	Synth	that	is	provided	by	this	application.
If	you	set	the	output	devices	to	the	same	external	synthesizer,	you	will
have	to	ensure	that	the	Midi	Keyboard	Output	is	set	to	a	midi	channel
not	used	by	the	Sequencer	Stream	Output.	If	you	set	the	output	devices
to	the	BuiltIn	synthesizer,	they	will	use	different	ports,	so	all	channels	can
be	used	on	both	devices.
The	synth	packaged	with	Windows	(Microsoft	GS	Wavetable	Synth	or
similar)	is	not	recommended.	This	is	poor	quality,	and	introduces	a
latency	(delay)	that	will	be	noticeable	even	if	the	sound	card	delay	is
small.
If	you	use	the	BuiltIn	Synth,	and	the	audiocard	is	connected,	a	panel	will
be	displayed	to	allow	the	soundfont,	volume,	tuning	and	FX	effects	to	be
set.
The	Soundfont	DropdownList	shows	all	the	soundfont	files	found	in	the
soundfonts	path.	The	list	can	be	changed	using	PlayMap	Menu	>
Configure	>	Paths	>	SoundFonts.	You	will	need	to	redisplay	the	Midi
Devices	Configuration	window	for	the	update	to	take	effect.
The	selected	soundfont	will	be	loaded	when	the	Connect	Button	is
clicked.	If	there	are	no	soundfont	files	found,	you	will	be	prompted	to
select	a	new	soundfonts	path.
Changes	will	be	actioned	after	one	of	the	the	Connect	or	Disconnect
Buttons	are	clicked,	and	will	be	saved	using	the	PlayMap	Menu	>	File	>
Save	Settings,	or	clicking	Save	Settings	and	Exit	Program	option
when	exiting	the	application.
A	description	of	the	controls	used	in	the	Midi	Devices	Configuration
Window	can	be	found	here.



Midi	Devices	Components
Midi	Keyboard	Input	ListBox
Select	Midi	Keyboard	Input	device.
Click	Connect	to	action	any	change.

Connect/Disconnect	Midi	Keyboard	Input	Button
Connect	or	disconnect	the	Midi	keyboard	input	port.

Connect/Disconnect	Midi	Keyboard	Output	Button
Connect	or	disconnect	the	Midi	keyboard	output	port.

Connect/Disconnect	Midi	Stream	Output	Button
Connect	or	disconnect	the	Midi	stream	output	port.	This	is	used	for
playing	MidiFiles.

Sequencer	Stream	Output	ListBox
Select	Midi	Output	device	for	streaming	midi	(MidiFile	playing).
Either	a	real	midi	device	(software	or	hardware),	or	the	synthesizer
supplied	by	this	application	(BuiltIn	Synth).
Click	Connect	to	action	any	change.

Midi	Keyboard	Output	ListBox
Select	Midi	Output	device	for	midi	keyboard.
Either	a	real	midi	device	(software	or	hardware),	or	the	synthesizer
supplied	by	this	application	(BuiltIn	Synth).
Click	Connect	to	action	any	change.

SoundFont	(Sequencer	Stream)	ListBox
Select	soundFont	for	Sequencer	Stream	Output	using	the	BuiltIn
Synthesizer.
See	Midi	Devices	Configuration	for	information	about	downloading	and
installing	soundfonts.



SoundFont	(Midi	Keyboard	Out)	ListBox
Select	soundFont	for	Midi	Keyboard	Output	using	the	BuiltIn
Synthesizer.
See	Midi	Devices	Configuration	for	information	about	downloading	and
installing	soundfonts.

Tuning	(Stream)	Slider
Adjust	tuning	for	the	Sequencer	Stream	Output	using	the	BuiltIn
Synthesizer.
Tuning	interval	is	plus	or	minus	one	semitone.
Supported	by	BuiltIn	Synth,	and	any	external	synth	that	responds	to
Midi	RPN	1	(Fine	Tuning).

Tuning	(Keyboard	Out)	Slider
Adjust	tuning	for	the	Midi	Keyboard	Output	using	the	BuiltIn
Synthesizer.
Tuning	interval	is	plus	or	minus	one	semitone.
Supported	by	BuiltIn	Synth,	and	any	external	synth	that	responds	to	Midi
RPN	1	(Fine	Tuning).

FX	(Stream)	Button
Open	the	FX	(Effects)	Window	for	the	Midi	Sequencer	using	the
BuiltIn	Synthesizer.

FX	(Keyboard	Out)	Button
Open	the	FX	(Effects)	Window	for	the	Midi	Keyboard	Output	using	the
BuiltIn	Synthesizer.

Close	Window	Button
Close	this	window

Help	Button



Show	help	documentation	for	this	window



FX	Effects
Active	CheckBox
Check	to	activate	FX	on	a	midi	port	using	the	BuiltIn	Synth.

Reset	Button
Click	to	set	all	values	back	to	their	default	values.

Dry	Mix	Slider
Set	the	gain	of	the	original	sound	in	the	final	mix.

Wet	Mix	Slider
Set	the	gain	of	sound	with	FX	effects	applied	in	the	final	mix.

Room	Size	Slider
Set	size	of	the	reverberation	chamber.

Damp	Slider
Set	degree	of	damping.

Width	Slider
Set	the	stereo	width	(how	much	the	reverb	part	from	left	and	right
channels	mix.)



Configure	Bezier	Window
This	is	used	to	edit	the	velocity	or	aftertouch	profiles.
A	Bezier	Curve	is	an	intuitive	way	of	drawing	a	curve	between	two	points.
This	is	used	in	this	application	to	draw	a	Keyboard	Velocity	Profile	or
an	Aftertouch	Profile.
You	can	find	out	how	to	use	a	Bezier	Curve	here



Configure	Bezier	Window
The	contents	of	the	window	include:

Bezier	Curve	Display
Graph	showing	the	Velocity	Profile	or	Aftertouch	Profile.
The	horizontal	axis	is	the	Velocity	or	Aftertouch	value	output	by	the	midi
keyboard.
The	vertical	axis	is	the	Velocity	or	Aftertouch	value	sent	to	the	midi
output.
The	red	circles	at	the	end	of	the	straight	line	can	be	dragged	by	the
mouse	to	change	the	curve.

Load	Default	Values	Button
Load	default	profile	-	a	straight	line	representing	no	change	in	Velocity	or
Aftertouch.

Close	Button
Close	this	window



SwitchKeys	WindowThis	allows	you	to	allocate	one	or	more	Actions	to	a	SwitchKey	(or
Sustain	Pedal).
The	grey	ComboBoxes	show	the	current	SwitchKey	allocated	to	the
Action	on	the	right.	If	this	is	blank,	then	no	SwitchKey	is	currently
allocated.
Click	one	of	the	grey	ComboBoxes	to	select	a	SwitchKey	to	associate
with	an	Action,	or	select	None	to	deselect	any	SwitchKey.
Any	changes	take	effect	immediately.	Use	PlayMap	Menu	>	File	>	Save
Settings	to	save	the	current	SwitchKey	settings.
The	SwitchKeys	should	occupy	the	bottom	octave	of	the	midi	keyboard.
This	can	be	configured	using	PlayMap	Menu	>	Configure	>	Midi
Keyboard	Ranges.
You	can	find	out	more	about	how	to	set	up	and	use	SwitchKeys	here.



SwitchKey	ComboBoxes
KBChord
Play	the	nearest	chord	note	to	the	played	note	whilst	SwitchKey	is	down.
If	nearest	note	is	already	sounding,	play	the	next	chord	note	up	or	down.
Allows	chords	to	be	played	more	easily.

Sustain
Activate	Sustain	whilst	SwitchKey	is	down.
This	is	the	normal	action	for	the	sustain	pedal.
Sustain	can	be	configured	to	be	the	normal	Midi	Sustain,	or	one	of	the
emulated	Sustain	Types.

Sync
The	Sync	SwitchKey	-	used	for	synchronizing	the	chords	to	an	audio
source.

Prev	Beat
Move	backwards	to	previous	beat.
This	is	used	whilst	playing	to	an	unsynchronised	audio	source.
See	How	To	Play	to	Live	Audio.

Next	Beat
Move	forward	to	next	beat.
This	is	used	whilst	playing	to	an	unsynchronised	audio	source.
See	How	To	Play	to	Live	Audio.

Prev	Bar
Move	backwards	to	previous	bar.
This	is	used	whilst	playing	to	an	unsynchronised	audio	source.
See	How	To	Play	to	Live	Audio.



Next	Bar
Move	forward	to	next	bar.
This	is	used	whilst	playing	to	an	unsynchronised	audio	source.
See	How	To	Play	to	Live	Audio.

Prev	Chord
Move	backwards	to	previous	chord.
This	is	used	whilst	playing	to	an	unsynchronised	audio	source.
See	How	To	Play	to	Live	Audio.

Next	Chord
Move	forward	to	next	chord.
This	is	used	whilst	playing	to	an	unsynchronised	audio	source.
See	How	To	Play	to	Live	Audio.



Configure	Paths
This	will	bring	up	a	Windows	Explorer	window	to	allow	you	to	select	a
path.
Paths	are	used	to	locate:

The	Project

SoundFont	Files	(*.sf2)

MidiFiles:	used	to	copy	a	matching	MidiFile	into	the	Project	folder	when
creating	a	new	Project

AudioFiles:	used	to	copy	a	matching	AudioFile	into	the	Project	folder
when	creating	a	new	Project



Configuring	Keyboard	Ranges

The	Keyboard	Ranges	Window	is	used	to	configure	your	midi	keyboard.	It	is	opened	from	PlayMap	Menu	>
Configure	>	Midi	Keyboard	Ranges.

It	allows	you	to	set	the	lowest	key	present	on	your	midi	keyboard,	and	the	lowest	key	that	you	want	to	be
displayed.

It	is	important	to	do	this	in	order	for	the	keyboard	keys	that	you	play	to	be	within	the	range	of	the	PlayMap.

It	also	matters	if	you	want	the	bottom	octave	of	the	midi	keyboard	to	be	used	for	SwitchKeys.



Miscellaneous	ConfigurationsThis	window	is	used	to	change	various	parameters.	These	are	saved	in
the	file	ChordCadenza.ini



Miscellaneous	Configurations	-	General
Load	TrackMap	on	.chp	Load	CheckBox
If	checked,	the	TrackMap	will	be	displayed	after	loading	a	Project
containing	a	MidiFile.

Send	AllNotesOff	after	Sustain	Up	CheckBox
This	is	normally	unchecked.	However,	if	you	find	some	notes	are	not
switched	off	after	releasing	the	sustain	pedal	or	SwitchKey,	you	can	set
this	to	send	a	midi	AllNotesOff	message	to	the	synthesizer.

ToolTips	Active	CheckBox
If	checked,	ToolTips	will	be	shown	over	window	components.
Note:	This	will	take	effect	immediately,	except	for	menu	items	that	require
the	application	to	be	restarted.

Prompt	to	Save	Settings	on	Exit	CheckBox
Check	to	show	a	window	with	options	to	save	or	not	save	the	.ini
configuration	files.	Otherwise,	the	ini	files	are	always	saved.

Disable	AutoSync	on	Audio	Play	CheckBox
Check	to	disable	automatic	audio	synchronisation.
This	will	allow	you	to	use	manual	chord	or	bar/beat	synchronisation	on	a
synchronised	audio	(.mp3)	file.

Undo/Redo	Capacity	Numeric	Input
Sets	the	maximum	number	of	events	allowed	in	the	Undo	or	Redo
stacks.
When	this	limit	is	reached,	the	oldest	event	will	be	removed.
This	change	will	be	effected	when:
ChordMap	Undo/Redo:	ChordMap	is	reloaded.
AudioSync	Undo/Redo:	Project	is	reloaded.
Lyrics	Undo/Redo:	Lyrics	window	is	reloaded.



Reset	Settings	Button
This	will	rename	all	Ini	files	to	Ini.BU,	overwriting	any	existing	Ini.BU	files.
It	will	then	restart	the	application,	using	default	values.
You	should	use	this	if	you	want	to	reset	all	global	parameters	to	their
default	values.

Restore	Settings	Button
This	will	rename	all	Ini.BU	files	to	Ini,	overwriting	any	existing	Ini	files.
It	will	then	restart	the	application,	using	the	new	Ini	files
You	should	use	this	if	you	want	to	restore	all	global	parameters	from	a
copy	saved	after	the	last	time	they	were	set	to	their	default	values.

Chord	Config	Button
Open	a	window	to	configure	the	chord	generation	parameters.
This	is	an	advanced	feature	that	you	normally	do	not	need	to	use,	but
you	are	welcome	to	try	changing	some	of	these	parameters	to	see	what
effect	it	has!
Any	changes	can	be	saved	to	the	ChotdCfg.ini	file,	and	you	can	always
reset	back	to	the	default	values	(factory	settings).

Chord	Ranks	Button
Configure	chord	ranks.	These	are	weightings	that	usually	favour	simple
chords	over	complex	chords	in	the	chord	generation	process.



Miscellaneous	Configurations	-	TimersThese	are	all	Numeric	Inputs

Sustain
The	time	(in	milliseconds)	to	wait	for	notes	to	be	considered	to	be	part	of
the	same	chord.
This	is	used	by	the	emulated	sustain	functions	-	see	Sustain	Types.

Stream	Resolution
This	is	the	resolution	used	to	play	Midi	events	from	a	midifile.	It	is
expressed	as	a	number	of	milliseconds.
Increasing	it	will	use	less	computer	memory	and	CPU.	A	decrease	will
make	the	midi	playing	more	accurate.
The	recommended	value	is	5.
A	Project	reload	is	required	to	effect	any	change	in	this	value.

Syncopation
The	time	interval	before	the	actual	chord	time	when	the	chord	becomes
active	during	playing.
This	is	to	allow	the	chord	to	be	played	just	before	a	beat	or	bar,	and	also
allows	for	any	keyboard	latencies.
The	time	is	expressed	as	a	fraction	of	a	midi	note.	The	default	value	is
1/16.	Heavily	syncopated	music	may	require	more	syncopation	(e.g.	1/8).
This	value	is	saved	in	the	application	ini	file	(ChordCadenza.ini).	It	is	the
default	used	if	not	overriden	by	the	ChordFile.



Miscellaneous	Configurations	-	ChordPlay
Display	Notes	per	Chord	Numeric	Input
Set	the	number	of	notes	to	display	for	each	chord	in	ChordMode.
Only	active	if	adjacent	CheckBox	is	checked.

Display	Notes	per	Chord	CheckBox
Activate	the	Display	Notes	per	Chord	number.
PlayMap	will	show	this	number	of	notes	for	each	chord	in	ChordMode.
The	chord	display	will	be	padded	out	or	truncated	to	fit.

Play	Notes	per	Chord	Numeric	Input
Set	the	number	of	notes	to	play	for	each	chord.
Only	active	if	adjacent	CheckBox	is	checked.

Play	Notes	per	Chord	CheckBox
Activate	the	Play	Notes	per	Chord	number.
ChordMode	and	KBChord	will	play	this	number	of	notes	when	a	single
midi	keyboard	key	is	pressed.
This	is	in	contrast	to	the	normal	play	method	for	ChordMode	or	KBChord
that	plays	only	one	note	for	each	midi	keyboard	key	press.
See	Modes	for	information	about	ChordMode	and	KBChord.



Miscellaneous	Configurations	-	Midi	Numeric	Inputs
Display	Resolution
This	is	the	resolution	used	by	the	display	windows	(TrackMap,	PlayMap,
and	ChordMap).
It	is	expressed	as	the	number	of	intervals	in	a	whole	note.	The
recommended	value	is	32.
Decreasing	it	will	use	less	computer	memory	and	CPU.
A	increase	will	make	the	midi	files	displays	more	accurate.
Change	effected	on	Project	reload.

Default	Song	Length	(WholeNotes)
Used	to	set	the	default	song	length	in	whole	notes	when	there	is	no
MidiFile.
The	song	length	can	be	changed	later	by	clicking	on	the	TSig	Window	in
the	ChordMap.



Miscellaneous	Configurations	-	File	Status
File	Status	Panel
This	shows	the	file	extension	of	all	Project	files,	if	that	file	is	active.
Otherwise,	shows	blank.



Initial	WindowThis	is	displayed	immediately	after	the	program	starts	for	the	first	time,
and	whenever	the	program	starts	again,	until	the	option	to	not	show
again	is	taken.
It	has	the	following	buttons:

Close	Button
Close	this	window

Close	Window	and	Don't	Show	Again	Button
Close	this	window	and	don't	show	again

Configure	Audio	Devices	Button
Configure	ASIO	and	non_ASIO	Soundcards

Configure	Midi	Device	and	SoundFonts	Button
Configure	Midi	Input	(Keyboard)	and	Output	(Keyboard	and	MidiFile
Player)	Devices
Choose	SoundFont	file
Adjust	Volume	and	Fine	Tuning
Configure	Special	Effects	(FX)

Configure	Keyboard	Ranges	Button
Set	Highest	and	Lowest	playable	notes	on	the	Midi	Keyboard
Set	PlayMap	display	range

Introduction	Button
Show	Introduction	Help	screen.

Save	Configuration	Button
Save	Global	Configuration	Parameters
Saves	any	changes	made	to	various	global	parameters	(as	opposed	to
parameters	only	associated	with	the	current	Project).

ChordCadenza.ini	(the	main	config	file)

Switch.ini	(SwitchKeys)



This	involves	saving	the	following	files	in	the	application	directory:frmNMColors.ini	(ChordMap	colours)

frmSCColors.ini	(PlayMap	colours)

ChordCfg.ini	(Chord	generation	parameters)

Chords.Ranks.ini	(Chord	Rank	values)



New	Project	WindowThis	window	is	displayed	when	PlayMap	Menu	>	File	>	New	Project	is
clicked,	or	PlayMap	>	New	Project	Button	is	clicked.
It	allows	you	to	create	a	new	Project	folder,	with	options	to	copy	an
existing	MidiFile	and	an	existing	AudioFile

.	



New	Project	Components
Copy	MidiFile	From	TextBox
Location	to	copy	a	MidiFile	from.
The	file	will	be	copied	to	the	Project	folder,	and	renamed	to
Project_Name.mid.

Copy	MidiFile	From	...	Button
Click	to	display	a	File	Explorer	window	to	select	a	MidiFile.
This	will	be	used	to	copy	the	selected	file	into	the	Project	folder.
The	file	will	be	renamed	to	Project_Name.mid.

Copy	AudioFile	From	TextBox
Location	to	copy	an	AudioFile	from.
The	file	will	be	copied	to	the	Project	folder,	and	renamed	to
Project_Name.ext,	where	ext	is	the	extension	of	the	original	AudioFile
(e.g.	mp3).

Copy	AudioFile	From	...	Button
Click	to	display	a	File	Explorer	window	to	select	an	AudioFile.
This	will	be	used	to	copy	the	selected	file	into	the	Project	folder.
The	file	will	be	renamed	to	Project_Name.ext,	where	ext	is	the	extension
of	the	original	AudioFile	(e.g.	mp3).

Project	Location	TextBox
Location	on	disk	of	the	Project

Project	Location	...	Button
Click	to	display	a	File	Explorer	window	to	select	the	location	on	disk	of
the	Project.

Add	Name	Subdirectory	to	Location	CheckBox
Check	to	add	the	Project	Name	as	a	subdirectory	to	the	Project



Location.
This	is	useful	for	keeping	all	files	associated	with	a	Project	in	one	folder.

Project	Name	TextBox
The	name	of	the	Project.
This	will	be	used	to	create	the	filename	qualifier	of	the	various	files	that
make	up	the	Project.
If	the	Add	Name	Subdirectory	to	Location	CheckBox	is	checked,	it	will
also	be	added	as	a	subdirectory	to	the	Project	Location.

Use	MidiFile	Qualifier	Button
Click	to	set	the	Project	Name	to	the	MidiFile	qualifier.

Use	AudioFile	Qualifier	Button
Click	to	set	the	Project	Name	to	the	AudioFile	qualifier.

OK	Button
Click	to	create	the	new	Project.
If	the	Project	location	(including	the	Project	subdirectory)	already	exists,
you	will	get	a	warning	message.

Cancel	Button
Close	the	window	without	making	any	changes.



Save	Project	As...	WindowThis	window	is	displayed	when	PlayMap	Menu	>	File	>	Save	Project
As...	is	clicked.
It	allows	you	to	save	a	Project	in	a	new	location	on	disk.

.	



Save	Project	As...	Components
Project	Location	TextBox
Location	on	disk	of	the	Project

Project	Location	...	Button
Click	to	display	a	File	Explorer	window	to	select	the	location	on	disk	of
the	Project.

Add	Name	Subdirectory	to	Location	CheckBox
Check	to	add	the	Project	Name	as	a	subdirectory	to	the	Project
Location.
This	is	useful	for	keeping	all	files	associated	with	a	Project	in	one	folder.

Project	Name	TextBox
The	name	of	the	Project.
This	will	be	used	to	create	the	filename	qualifier	of	the	various	files	that
make	up	the	Project.
If	the	Add	Name	Subdirectory	to	Location	CheckBox	is	checked,	it	will
also	be	added	as	a	subdirectory	to	the	Project	Location.

OK	Button
Click	to	save	the	Project	using	the	new	location	and	name	.
If	the	Project	location	(including	the	Project	subdirectory)	already	exists,
you	will	get	a	warning	message.

Cancel	Button
Close	the	window	without	saving	the	Project.



AudioSync	Configuration	WindowThis	is	used	to	configure	and	manage	the	audio	synchronisation	function.
An	introduction	to	this	function	can	be	found	here.
The	AudioSync	Configuration	Window	allows	you	to	manage	the
synchronisation	data.	This	consists	of	two	tracks:	the	Record	Track	and
the	Play	Track.
The	Record	Track	is	created	when	you	sync	an	AudioFile	using	the
Sync	Audio	Button	on	the	ChordMap	or	TrackMap.
The	Play	Track	controls	the	current	cursor	when	playing	an	AudioFile.
This	is	located	in	the	Project	directory	with	the	file	extension	.chtc.
The	Record	Track	is	copied	to,	or	merged	with,	the	Play	Track	from	the
AudioSync	Configuration	Window.
Extension	.chtc	saves	byte	offset	values	for	an	AudioFile.
Other	controls	in	this	window	allow	you	to	manage	the	synchronisation
data	and	AudioFile	position.



AudioSync	Menu
File	->	Save	Play	to	File
Save	audio	synchronisation	data	in	the	Project	directory	with	extension
.chtc

Edit	->	Selected	->	Remove	Record
Clear	the	Record	Track	from	the	synchronisation	data.

Edit	->	Selected	->	Remove	Play
Clear	the	Play	Track	from	the	synchronisation	data.

Edit	->	Selected	->	Copy	Record	to	Play
Clear	the	Play	Track	and	copy	all	data	in	the	Record	Track	to	the	Play
Track

.	



AudioSync	Components
Update	Display	Button
Updates	the	display	with	the	current	data.

Merge	Record	To	Play	Button
Merge	the	Record	Track	into	the	Play	Track
If	there	is	any	inconsistency	in	the	merged	data,	a	message	will	be
shown.

Clear	Play	and	Move	Record	To	Play	Button
Clear	the	Play	Track	and	move	the	Record	Track	to	the	Play	Track

Clear	Record	Button
Clear	the	Record	Track.

Clear	All	Button
Clear	the	Record	Track	and	the	Play	Track.

Offset	Times	Button
Display	a	window	to	enter	the	time	(in	milliseconds)	to	change	each	beat
by.
This	will	cause	the	play	cursor	to	be	displayed	later	if	the	time	is	positive,
or	earlier	if	negative.
This	is	usually	only	required	if	you	are	playing	the	audio	file	with	a
soundcard	that	has	a	latency	that	is	significantly	different	from	the	one
that	was	used	when	the	synchronisation	file	(*.chtc)	was	created.

Offset	Beats	Button
Display	a	window	to	enter	the	number	of	beats	to	move	the
synchronisation	points	by.
This	can	be	a	postive	or	a	negative	number.

Undo	Button



Undo	last	change.
Shortcut	key	is	Ctrl/Z.

Redo	Button
Redo	last	undone	change.
Shortcut	key	is	Ctrl/Y.

Save	Play	To	File	Button
Save	the	Play	Track	to	the	synchronisation	file.

Position	Slider
Set	the	start	position	in	the	AudioFile,	or	display	current	position.

Start	from	Position	Time	CheckBox
Check	to	use	the	Position	Slider	setting	as	the	start	position.

Numeric	Display	in	Lower	Right	Corner	of	Window
This	shows	the	current	position	in	the	AudioFile.	The	format	of	the
display	is:

Position	in	minutes:seconds	/	Length	in	minutes:seconds

Position	in	bytes	/	Length	in	bytes



CalcKeysThis	is	used	to	calculate	the	keys	in	a	Project	from	the	MidiFile.
In	order	to	do	this,	each	bar	of	the	MidiFile	is	analysed.	Once	this	has
been	done,	all	the	bars	are	examined	together	in	order	to	find	the
optimum	keys	for	the	music	as	a	whole.	This	involves	using	an	Inertia
value	-	the	higher	the	Inertia,	the	less	often	the	key	is	likely	to	change.
CalcKeys	can	use	the	tracks	selected	in	the	TrackMap,	or	all	tracks,	or
the	chords	as	input.
Any	percussion	tracks	(midi	channel	10)	or	pitchbent	notes	are	omitted
from	the	algorithms	used	by	CalcKeys.
When	the	CalcKeys	window	is	displayed,	it	calculates	the	keys	for	all
valid	Inertias.	This	can	be	repeated	with	the	same	or	different
parameters	using	the	Recalculate	Button.	The	Apply	or	Apply	and
Close	buttons	can	then	be	used	to	apply	the	calculated	keys	to	the
current	MidiFile,	using	the	selected	Inertia.
The	only	part	of	the	CalcKeys	window	that	you	really	need	to	use	is	the
Apply	and	Close	Button.	The	other	controls	you	can	experiment	with	if
you	wish,	but	it	isn't	normally	necessary	to	change	any	of	the	values	they
contain.



CalcKeys	Compoenets
Load	Text	Keys	CheckBox
Load	keys	from	the	ChordFile.	Used	to	compare	calculated	keys	with.

Use	ChordFile	CheckBox
Check	to	calculate	keys	from	the	ChordFile	chords.
This	is	only	useful	if	you	have	don't	have	a	midifile.	It	is	likely	to	be	less
accurate	than	using	a	midifile,	but	can	be	useful	if	you	have	created	a
ChordFile	manually.

Flat	Option
Give	equal	weight	to	all	selected	notes	present	in	the	MidiFile	(excluding
percussion	and	pitchbent	notes.)

Weighted	Option
Weight	the	notes	according	to	the	number	of	tracks	that	contain	the	note.

Zero	Inertia	Option
No	Inertia	-	set	the	key	for	a	bar	independently	of	other	bars.

Non-Zero	Inertias	Options
Set	Inertia	-	the	greater	the	Inertia,	the	less	often	the	key	will	change.

Recalculate	Button
Calculate	the	keys	for	all	Inertias	and	display	the	results	in	the	main
panel.

Apply	Button
Apply	the	calculated	keys	to	the	MidiFile,	using	the	selected	Inertia.

Apply	and	Close	Button
Apply	the	CalcKeys	algorithm	to	the	MidiFile	and	close	this	window.



SummaryThis	is	used	to	display	information	about	the	loaded	MidiFile	and	chords.
The	main	window	shows	summary	information	for	each	track	of	the
MidiFile.	The	columns	show:

Tk
Track	Number	(1	-	32).

Ch
Midi	Channel	Number	(1-16).

Count
Number	of	Midi	On	events.

Min
Minimum	pitch	(Notename	and	Octave).

Max
Maximum	pitch	(Notename	and	Octave).

Min
Minimum	pitch	(midi	pitch	value)

Max
Maximum	pitch	(midi	pitch	value)

Rng
Pitch	Range	(maximum	midi	pitch	-	minimum	midi	pitch).

Style
The	Track	Style.

Poly



Degree	of	polyphony	(average	simultaneous	notes	played.)

Patch
General	Midi	Instrument

Title
Track	Description



Summary	Buttons
Chord	Names
Click	to	show	a	list	of	all	the	chords	defined	in	the	Chords.ini	file.
Shows

Chord	Name

Rank	(the	lower	the	rank,	the	more	common	the	chord)

Notes	(for	root	note	'C')

Time	Signatures
Click	to	show	time	signatures.

Tempos
Click	to	show	the	tempos.
Shows	Tempo	in	Beats	per	Minute,	MidiTempo	in	Microseconds	per	Midi
Quarternote,	and	MSecsPerQI	as	Milliseconds	per	Quantize	(Display)
Interval

Keys
Click	to	show	the	keys.

Attributes
Click	to	show	some	global	values.

Close
Close	this	window



Load	Project	WindowThis	window	may	be	displayed	after	opening	a	file	or	folder	from	the
Load	Project	Open	File	Dialog.
It	allows	you	to	choose	from	a	collection	of	ChordFiles	to	load	(or	save)
as	part	of	the	Project.
When	loading	a	project,	the	window	will	only	be	shown	if	there	is	more
than	one	ChordFile	associated	with	the	current	Project.



Load	Project	Components
Filename	Extensions	ListBox
Shows	a	list	of	ChordFile	filename	extensions	present	on	disk
associated	with	the	Project.
Selected	name	will	be	used	as	the	loaded	ChordFile.
Click	Load	File	Button,	or	doubleclick	the	selected	filename,	to	load	a
Project	containing	the	selected	filename.

Delete	Button
Click	to	delete	the	selected	file.

Load	Project	(or	Save	File)	Button
Click	to	load	a	Project	containing	the	selected	filename,	or	to	save	the
ChordFile	to	the	selected	filename.

Cancel	Button
Close	this	Window	without	taking	any	action.



Save	ChordFile	As...	WindowThis	window	is	displayed	whenever	you	click	the	Save	As	Button	on	the
ChordMap.
It	allows	you	to	choose	the	number	(0	-	9)	to	append	to	the	.chp
extension	of	the	ChordFile	name.	This	will	let	you	choose	from	a
collection	of	ChordFiles	whenever	you	load	a	Project.	You	can	use	this
to	save	ChordFiles	that	have	been	created	in	different	ways	(e.g.	by
using	different	selected	tracks,	different	time	divisions,	or	copied	from
sheet	music.)



Save	ChordFile	As...	Components
Filename	Extensions	ListBox
Shows	a	list	of	all	ChordFile	filename	extensions	(.chpN),	where	N	=	0	-
9.
Selected	name	will	be	used	as	the	saved	filename.

Delete	Button
Click	to	delete	the	selected	file.

Save	File	Button
Click	to	save	the	ChordFile	with	the	selected	filename	extension.

Cancel	Button
Close	this	Window	without	taking	any	action.



Save	MidiFile	As...	WindowThis	window	is	displayed	whenever	you	click	the	Save	MidiFile	As
Button	on	the	PlayMap,	or	the	Save	Midi	Button	on	the	TrackMap.
You	would	normally	save	the	MidiFile	if	you	want	to	save	the	chords	in	a
MidiFile	track	(to	be	used	with	another	application),	or	to	save	your	last
playing	session	in	a	MidiFile	track.
The	window	presents	various	options	for	doing	this.	If	you	click	on	the
Save	As	...	Button,	it	will	display	a	dialog	for	inputting	the	file	location	and
path	to	save	to.



Save	MidiFile	As...	Options
Save	Muted	Tracks	CheckBox
Save	muted	tracks	along	with	non-muted	tracks.

Save	Chord	Names	as	Labels	CheckBox
Save	chord	names	as	midi	labels.

Save	Chord	Track	CheckBox
Save	generated	chords	as	a	midi	track.

Chord	Root	Position	CheckBox
Save	chords	in	root	position.

Chord	Channel	Numeric	Input
The	midi	channel	number	to	use	for	the	chord	track.

Chord	Track	Title	TextBox
Text	associated	with	the	chord	track	in	the	MidiFile.	If	nothing	is	entered,
"Chords"	will	be	used.

Save	As	...	Button
Show	the	Save	File	Dialog	to	allow	the	MidiFile	location	and	filename	to
be	entered	before	saving	the	MidiFile	with	the	options	in	this	window.

Cancel	Button
Close	the	window	without	saving	the	MidiFile.



Lyrics	EditorThis	is	used	to	edit	any	lyrics	associated	with	a	project.	Simple	text
editing	functions	are	provided	for	changing,	inserting,	or	deleting	lyrics
lines.	One	lyrics	line	corresponds	to	one	bar	of	music.
Lyrics	can	be	useful	for	locating	a	place	in	the	music,	especially	when
synchronising	to	an	audio	file.	They	can	also	be	used	to	locate	cue	points
in	the	music	(e.g.	the	start	of	a	solo	instrument).
Changes	are	only	updated	on	the	ChordMap,	TrackMap,	and	PlayMap
when	the	Update	Button	is	clicked.	Saving	the	project	will	save	the
current	lyrics	as	displayed	on	these	Maps	as	a	file	ending	with	the
extension	.chl.
Updates	can	be	undone	or	redone	using	the	Undo	Update	and	Redo
Update	Buttons.	Any	changes	made	before	using	the	Update	Button
cannot	be	undone	until	after	the	Update	Button	is	clicked.
It	is	advisable	to	make	sure	the	time	signature(s)	are	correct	before
entering	lyrics.	If	any	time	signatures	are	changed,	the	lyrics	will	probably
become	out	of	sync	with	the	new	bars,	and	will	need	to	be	edited.
If	lines	are	inserted	with	the	editor,	or	a	time	signature	is	changed,	some
lines	may	me	moved	beyond	the	last	bar.	These	lines	will	still	be	saved,
even	though	they	are	not	visible.	They	can	be	restored	by	reversing	the
action	that	caused	them	to	go	beyond	the	last	bar,	or	using	the	Undo
Button.



StylesStyles	are	used	to	categorise	Midi	Tracks	by	analysing	the	notes	played
in	the	track.
If	a	track	is	empty,	it	is	assigned	a	Style	of	NoStyle.
If	all	the	notes	are	on	midi	channel	10,	it	is	assigned	a	Style	of
Percussion.
If	the	track	is	nearly	empty,	it	is	assigned	a	Style	of	Sparse.
If	the	track	contains	mainly	block	of	chords,	it	assigned	a	Style	of
BChords.
If	the	track	contains	mainly	bass	notes,	it	assigned	a	Style	of	Bass.
If	the	track	contains	nearly	all	chord	notes	(by	comparing	it	with	the
ChordFile),	it	is	assigned	a	Style	of	AChords.
Otherwise,	it	is	assigned	a	Style	of	Melody.



ModesThere	are	2	Modes	used	by	this	program:

KeyBoardMode

All	of	the	keys	of	the	midi	keyboard	are	set	to	their	normal	pitches
(subject	to	any	transposition	that	may	be	active).
This	may	be	used	with	the	KBChord	SwitchKey,	which	will	play	the
nearest	chord	note	to	the	key	actually	played.

ChordMode
Only	the	white	keys	of	the	midi	keyboard	are	active,	and	these	are
assigned	to	chord	notes.



Sustain	Types
Normal
Use	the	normal	Midi	Sustain	function.	This	will	send	Midi	Sustain	On/Off
messages	in	response	to	the	sustain	pedal	or	SwitchKey.

Replay
Emulate	sustain	by	leaving	all	chord	notes	switched	on	until	the	sustain
pedal	or	SwitchKey	is	released,	or	a	new	chord	is	played.
A	chord	is	defined	as	any	number	of	notes	played	within	the	time	interval
specified	with	the	Sustain	Numeric	Input	in	this	window.

Carry	Over
Same	as	Replay,	but	carries	over	any	notes	that	are	also	in	the	next
chord.
This	has	the	effect	of	making	chord	changes	smoother	for	non-
percussive	instruments.

Send	Ctlr
Same	as	Replay,	but	uses	Midi	Sustain	On/Off	messages	instead	of
Midi	Note	On/Off	messages.
It	is	recommended	to	only	use	this	if	you	are	having	problems	with	the
normal	Replay.



How	To	Create	a	New	Project
A	Project	is	a	collection	of	files	associated	with	a	particular	piece	of
music.	These	are	located	in	a	Project	folder.
You	can	create	a	new	Project	using	the	PlayMap	>	New	Project	Button
or	PlayMap	Menu	>	File	>	New	Project.	This	will	display	the	New
Project	Window.
This	will	allow	you	to	create	and	load	a	Project	folder.	You	can	also
optionally	copy	a	MidiFile	(to	create	chords	from,	or	to	play	along	to)	and
an	AudioFile	(to	play	along	to)	into	the	Project	folder.
Once	the	Project	folder	has	been	created,	you	can	use	the	functions	of
this	program	to	create	a	ChordFile,	an	AudioSyncFile,	and	a
LyricsFile.



How	To	Insert	Keys	and	Chords	from	an	External	Source
This	application	can	generate	the	keys	and	chords	of	the	music	from	a
MidiFile.	However,	you	may	want	to	insert	chords	into	the	ChordFile
directly	from	an	external	source	(sheet	music,	lead	sheet	etc).	This	can
be	done	with	the	ChordMap	window.
You	can	either	load	an	existing	Project	containing	a	ChordFile,	or	start
with	a	Project	not	containing	any	chords.

Open	the	ChordMap	window
If	the	ChordMap	window	is	not	yet	opened,	you	can	open	it	using	the
ChordMap	Button	on	the	PlayMap.
If	the	ChordMap	is	empty,	you	may	prompted	to	initialize	a	new
ChordMap.	Click	OK	to	this.
If	there	are	already	chords	in	the	ChordMap,	you	can	either	override
them	as	you	insert	new	chords,	or	clear	the	existing	chords	with	the	Cut
Button.
The	chord	input	window	is	near	the	top	of	the	ChordMap	(labelled	Chord
Names).	This	will	show	any	chords	currently	present	in	the	ChordFile.
If	your	chord	source	(sheet	music	etc.)	is	in	a	different	key	to	the
MidiFile,	it	will	need	to	be	transposed.	This	can	be	done	by	using	the
transpose	controls.

Set	the	Key
If	the	keys	of	the	ChordFile	have	not	yet	been	set,	this	should	be	done
using	How	To	Update	Keys	or	How	To	Generate	Keys.

Transpose
You	can	skip	this	section	if	the	external	source	is	in	the	same	key	as	the
music.
Transpose	Chord	Names	will	transpose	the	Chord	Names	pane,	but
not	the	Chord	Notes	pane.	Transpose	Chord	Notes	will	transpose	the
Chord	Notes	pane,	but	not	the	Chord	Names	pane.	This	will	allow	you



to	type	in	chord	names	from	an	external	source,	and	transpose	the	notes.
If	you	have	an	external	source	that	is	in	a	different	(initial)	key	to	the
ChordFile	or	MidiFile,	you	can	use	Transpose	Chord	Names	to	match
the	key	with	the	external	source.	If	you	don't	know	what	key	the	midi	or
audio	file	is	in,	you	can	transpose	the	chords	later	on.	You	can	also
transpose	all	the	keys	with	the	Transpose	Keys	Buttons.
For	example,	if	your	source	is	sheet	music	in	the	key	of	C	major,	but	your
MidiFile	is	in	the	key	of	C#	major,	you	should	set	Transpose	Chord
Names	to	-1.	This	is	because	the	chordname	text	is	one	semitone	lower
than	the	midi	file.
If	you	have	a	synchronised	AudioFile	but	no	MidiFile,	and	don't	know
what	key	the	music	is	in,	you	should	start	typing	in	the	chords	until	some
time	after	the	first	synchronised	beat.	You	can	then	try	playing	along	to	it,
and	transpose	the	chord	notes	until	it	sounds	right.	If	you	can't	find	a
transposiiton	that	sounds	good,	you	may	have	to	adjust	the	fine	tuning
(see	Midi	Devices	Components).
Note:	The	Chord	Notes	pane	represents	the	chord	notes	and	keys	that
will	actually	be	saved	in	the	ChordFile.

Type	in	the	Chords
The	chords	can	now	be	typed	in	from	the	external	source.	Click	on	the
cell	you	want	to	update	and	type	in	the	name,	as	shown	in	the	external
source.	The	program	should	recognise	most	chords	and	variations.
If	you	type	in	something	that	is	not	recognised	as	a	valid	chord,	the
program	will	restore	the	original	value.
You	can	change	the	current	cell	position	with	the	keyboard
up/down/left/right	keys,	and	delete	a	chord	with	backspace	or	delete.
(You	may	need	to	click	on	a	cell	if	the	Chord	Names	window	is	not	the
currently	active	window.)

Save	the	Chords

You	can	check	the	chords	in	the	Chord	Notes	pane.	This	will	show	the
notes	of	the	chords.	You	can	change	any	notes	on	this	screen	by	clicking
with	the	mouse	-	this	is	documented	elsewhere.



To	save	the	chords	in	the	ChordFile,	click	the	Save	Project	or	Save
Chords	As	Button	in	the	ChordMap	window.

Further	Information
More	information	about	using	the	ChordMap	to	generate	chords	can	be
found	here.



How	To	Create	a	Velocity	or	Aftertouch	Profile	using	a
Bezier	Curve
A	Bezier	Curve	is	an	intuitive	way	of	drawing	a	curve	between	two	points.
This	is	used	in	this	application	to	draw	a	keyboard	velocity	profile	or	an
aftertouch	profile.	If	yout	midi	keyboard	does	not	support	key	velocity	or
aftertouch,	or	you	key	velocity	is	set	to	a	constant	value,	the	Bezier	Curve
will	not	be	of	any	use.
The	diagrams	below	show	examples	of	velocity	profiles	that	could	be
used.

	



The	curve	on	the	left	show	the	default	velocity	profile,	where	the	output
velocity	is	the	same	as	the	input	velocity.
The	curve	on	the	right	shows	a	velocity	profile	with	more	sensitivity	in	the
middle.

Drawing	a	Velocity	Bezier	Curve
First,	display	the	Velocity	Bezier	Curve	by	selecting	PlayMap	Menu	>
Configure	>	Bezier	>	Velocity.
Then,	click	on	the	red	circles	and	drag	the	mouse	to	move	the	spline
(straight	line)	around.	This	will	change	the	shape	of	the	curve.	With	a	little
practice,	you	can	change	the	curve	in	almost	any	way.
You	can	restore	the	default	at	any	time	with	the	Button	at	the	bottom	of
the	window.
The	curve	will	be	saved	with	the	rest	of	the	application	settings.

Drawing	an	Aftertouch	Bezier	Curve
If	your	keyboard	has	Aftertouch,	you	can	create	an	Aftertouch	profile
using	PlayMap	Menu	>	Configure	>	Bezier	>	Aftertouch,	using	the
same	method.



How	To	Set	Up	SwitchKeys	and	the	Sustain	Pedal
SwitchKeys	allow	you	to	perform	functions	(like	changing	Mode,	or
synchronizing)	from	your	Midi	keyboard.	The	same	functions	can	be
performed	from	your	sustain	pedal	(if	you	have	one).

Setting	Up	the	Midi	Keyboard
In	order	to	use	SwitchKeys,	you	will	need	to	make	sure	the	bottom
octave	of	your	Midi	keyboard	is	reserved	for	the	SwitchKeys.	This	can
be	done	by	going	to	PlayMap	Menu	>	Configure	>	Midi	Keyboard
Ranges

Setting	SwitchKeys
The	SwitchKey/Pedal	Configuration	window	can	be	opened	from
PlayMap	Menu	>	Configure	>	SwitchKeys/Pedal
From	here,	you	can	select	a	SwitchKey	or	Pedal	to	assign	to	any
SwitchKey	action.	A	SwitchKey	or	Pedal	can	contain	multiple	actions.
The	settings	will	be	saved	if	you	select	File	>	Save	Settings	from	the
PlayMap	Menu.

Sustain	Function
The	Sustain	Pedal	normally	sends	Midi	Sustain	On	and	Off	messages
to	the	midi	synthesiser.	This	works	well	for	percussion	instruments	like
the	piano,	but	is	not	really	suitable	for	other	instruments.
By	default,	this	application	uses	Midi	Note	Off	messages	to	emulate	the
sustain	function	when	playing	chords	from	a	ChordFile.	It	recognises
when	new	chords	are	being	played,	and	sends	Midi	Note	Off	messages
to	switch	off	the	old	chord.	This	is	especially	useful	if	you	are	using
ChordMode	or	KBChord.
You	can	change	this	behaviour	by	setting	the	Sustain	Action	controls	in
the	Miscellaneous	Configuration	window.	This	can	be	opened	from
PlayMap	Menu	>	Configure	>	Miscellaneous
The	controls	in	the	Sustain	Action	panel	are:

Replay:	Use	Midi	Note	Off	to	emulate	sustain	and	switch	off	old	chord
(default).

Carry	Over:	Same	as	Replay,	but	don't	send	Midi	Note	Off	if	pitches	are
the	same.	(This	allows	for	smoother	chord	changes.)



Send	Sustain	Ctlr:	Works	better	on	some	synthesizers.

Normal:	Send	Midi	Sustain	On	and	Off	messages	(normal	sustain	pedal
function).

Auto:	Set	the	sustain	automatically	when	the	Midi	patch	(instrument)
changes	to	be	the	most	suitable	option.

If	no	ChordFile	is	loaded,	the	keyboard	defaults	to	playing	the	actual
notes	on	the	keyboard,	and	the	sustain	function	also	defaults	to	normal.

Further	Information
More	information	about	using	the	SwitchKeys	window	can	be	found
here.



How	To	Generate	Chords	from	a	MidiFile
If	you	haven't	already	done	so,	load	a	Project
This	should	contain	at	least	a	MidiFile	(*.mid)	of	the	piece	of	music	you
want	to	generate	the	chords	for.

Open	the	ChordMap	Window
If	a	ChordFile	is	present,	but	empty,	you	should	get	a	warning	about
there	being	no	notes	in	the	ChordFile	-	click	OK	and	continue.
If	the	ChordMap	window	is	not	visible,	click	the	ChordMap	Button	on	the
PlayMap.
This	will	open	the	ChordMap	window	that	shows,	in	the	Midi	pane,	all	of
the	notes	in	the	MidiFile	condensed	into	one	track	(excluding	percussion
and	pitchbent	notes).
The	Chord	Notes	pane	shows	any	chords	that	are	in	the	ChordFile.	You
can	clear	this	by	clicking	the	Cut	Button	at	the	the	top	of	the	window.

Generate	Chords
There	are	many	options	in	the	ChordMap	window,	but	for	now	you	can
just	take	the	default	options	and	click	the	Generate	Chords	Button	near
the	top	of	the	window.
If	you	haven't	generated	or	edited	the	keys	yet,	you	should	see	a	dialog
asking	whether	you	want	to	invoke	CalcKeys.	The	keys	are	used	by	the
chord	generation	algorithms.	Unless	you	are	sure	the	MidiFile	keys	are
OK,	you	should	select	one	of	the	CalcKeys	options	and	then	click	Apply
and	Close	from	the	CalcKeys	window.	More	information	about
CalcKeys	can	be	found	here
This	will	generate	the	chords	for	the	whole	MidiFile,	which	will	be
displayed	in	the	Chord	Notes	pane.	The	names	of	the	chords	will	also	be
displayed	in	the	text	boxes	near	the	bottom	of	the	window.

Save	Keys	and	Chords	to	a	ChordFile
Click	the	Save	Chords	As...	or	Save	Project	Button	to	save	the	chords



in	the	ChordFile.
The	ChordFile	(.chp0)	will	be	saved	in	the	same	directory	as	the
MidiFile	(.mid).
It	contains	information	about	the	chords	and	keys,	as	well	as	some
miscellaneous	information.	It	is	the	main	file	that	is	used	by	the	program
alongside	a	MidiFile.
It	can	be	read	or	edited	by	a	text	file	editor	like	Notepad,	although
manually	editing	the	file	is	generally	not	recommended.

Further	Information
More	information	about	using	the	ChordMap	can	be	found	here.



How	To	Generate	Keys	from	a	MidiFile
If	you	haven't	already	done	so,	load	a	Project
This	should	contain	at	least	a	MidiFile	(*.mid)	of	the	piece	of	music	you
want	to	generate	the	keys	for.
This	should	open	the	TrackMap	window.

Select	which	tracks	you	want	to	use	to	calculate	the	keys	using	the
TrackMap	Window.
It's	usually	OK	to	select	all	tracks,	using	the	Check	All	Button	at	the	top
of	the	TrackMap	window.
Any	percussion	tracks	or	notes	that	have	had	pitchbend	applied	will	be
ignored	by	CalcKeys	.

Click	the	"Calc	Keys"	Button	on	the	TrackMap
This	will	bring	up	the	CalcKeys	window,	which	contains	a	table	of
calculated	keys	for	each	bar.
There	are	a	number	of	options	on	here	for	fine	tuning	how	the	keys	are
calculated.	However,	the	default	options	work	very	well	for	most	midifiles.
The	column	labelled	with	an	Inertia	of	'90'	will	be	used	by	default,	and	is
usually	the	most	accurate.	You	can	select	another	inertia	by	using	the
Inertia	option	buttons.
(Note:	the	higher	the	inertia,	the	less	frequently	the	key	is	likely	to
change.)

Generate	the	Keys
Click	the	Apply	or	Apply	and	Close	Button	to	generate	the	keys	(and
close	the	window).

Further	Information
More	information	about	using	the	CalcKeys	window	can	be	found	here.



How	To	Update	Keys	and	Modulate
This	shows	you	how	to	update	the	keys	of	a	ChordFile	manually.	This
can	be	used	instead	of,	or	after	using	CalcKeys.
It	does	not	change	any	of	the	chords	of	the	ChordFile,	except	possibly
the	harmonic	spelling	of	chord	root	notes	(e.g.	C#	may	be	switched	for
Db).
If	you	regenerate	the	chords	after	changing	keys,	it	may	change	some
chords.

Open	the	ChordMap	window
You	can	either:

Use	PlayMap	Menu	>	File	>	Load	Project	to	load	a	Project	containing	a
ChordFile.

Use	PlayMap	Menu	>	File	>	Load	Project	to	load	a	Project	without	a
ChordFile	and	follow	the	prompts	to	create	an	empty	ChordFile.

Use	PlayMap	Menu	>	File	>	New	Project	to	load	a	new	Project	and
follow	the	prompts	to	create	an	empty	ChordFile.

Update	Keys
If	you	click	anywhere	in	the	Keys	(Names)	or	Keys	(Notes)	pane	of	the
ChordMap	window,	a	context-sensitive	submenu	will	appear.	This	will
allow	you	to	change	or	remove	an	existing	key,	or	add	a	new	key.	All
keys	must	be	on	a	bar.
If	the	source	you	are	using	for	your	keys	and	chords	is	transposed
relative	the	MidiFile	or	AudioFile,	you	should	enter	the	keys	in	the	Keys
(Names)	pane.	Otherwise,	you	can	enter	the	keys	in	either	the	Keys
(Names)	or	Keys	(Notes)	pane.	Either	way,	both	panes	will	be	updated
together.
The	ChordMap	provides	functions	for	transposing	the	chord	names	and
keys,	the	chord	notes	and	keys,	or	just	the	keys.	This	allows	you	to
transpose	the	chord	notes	and	keys	at	any	time.

Save	Keys
Keys	will	be	saved	when	the	ChordFile	is	saved	using	the	Save	or	Save
As	Button	in	the	ChordMap.



How	To	Update	Time	Signatures
The	ChordMap	provides	a	way	of	updating	time	signatures	in	a
ChordFile.
Generally,	it	is	a	good	idea	to	make	sure	the	time	signature(s)	of	the
music	are	correct	before	inputting	any	chords	or	lyrics,	or	synchronising
audio.	If	you	are	using	a	MidiFile,	the	time	signatures	will	be	copied	from
there.	You	should	only	then	need	to	update	the	time	signatures	if	they	are
incorrect.

Open	the	ChordMap	window
Click	the	ChordMap	Button	from	the	PlayMap	or	TrackMap.	If	you
haven't	loaded	a	ChordFile,	a	window	should	be	displayed	to	create	a
new	ChordFile	with	a	maximum	number	of	bars.	Click	OK	to	proceed.

Update	Time	Signatures
If	you	click	on	anywhere	in	the	TSig	pane	of	the	ChordMap,	you	will	get
a	menu	for	updating	time	signatures.
This	will	change	the	position	of	time	signatures,	but	will	not	affect	the
absolute	position	(ticks)	of	chords	or	pitches.
The	menu	contains	the	following	submenu	items:

Set	TSig	to	End
Change	the	time	signature	from	the	current	cursor	position	to	the	end
of	the	song.
All	time	signatures	after	the	current	cursor	will	be	replaced	with	the
new	time	signature.

Change	TSigs	in	Selected	Area
Change	the	time	signature(s)	in	the	selected	area	to	the	new	time
signature.
If	the	new	time	signature	does	not	fit	the	selected	area	exactly,	a	filler
bar	will	be	inserted.	This	should	ensure	that	any	bars	after	the	selected
area	remain	the	same.
If	you	try	to	put	a	new	time	signature	into	a	selected	area	that	is	too
small,	you	will	get	an	error	message.

Remove	TSigs	from	Selected	Area



Remove	time	signatures	from	the	selected	area.
This	will	shift	any	time	signatures	after	the	selected	area	towards	the
start,	by	the	number	of	bars	in	the	selected	area.

Insert	TSig	in	Selected	Area
Insert	a	new	time	signature	at	the	start	of	the	selected	area.	The	time
signature	of	the	new	bars	is	selected	from	a	drop-down	list.
This	will	shift	any	time	signatures	after	the	selected	area	towards	the
end,	by	the	number	of	bars	in	the	selected	area.	Any	time	signatures
moved	beyond	the	end	will	be	deleted.

Change	Song	Length
Brings	up	a	window	to	change	the	length	of	the	song.
This	will	only	be	active	if	there	is	no	MidiFile	associated	with	the
project.



Notes
Time	signature	changes	can	be	undone	or	redone	using	the	Undo	and
Redo	Buttons	at	the	top	of	the	window.
The	position	of	chords	(midi	ticks)	will	not	be	changed	after	updating	the
time	signatures.	This	means	if	a	chord	was	aligned	to	a	bar,	it	may	no
longer	be	aligned	after	updating	a	time	signature.	Regenerating	the
chords	may	produce	a	better	alignment	to	the	new	bars.
Any	lyrics	or	audio	synchronisation	that	has	already	been	done	for	the
current	project	will	need	to	be	redone	if	a	time	signature	is	changed.



How	To	Play	Chords	along	with	a	MidiFile
If	you	haven't	already	done	so,	load	a	Project	containing	a	MidiFile	and	a
ChordFile
(See	How	to	Generate	Chords	from	a	MidiFile	or	How	To	Insert	Keys
and	Chords	from	An	External	Source	to	find	out	how	to	create	a
ChordFile.)

Open	The	PlayMap
This	shows	the	current	position	in	the	MidiFile	in	a	display	that	shows	the
generated	chords	rolling	downwards	as	the	music	progresses.	This
makes	it	easier	to	improvise	and	play	along	with	the	MidiFile.
If	possible,	you	should	try	to	locate	your	keyboard	below	your	computer
screen,	and	resize	the	PlayMap	so	that	your	keyboard	keys	match	the
PlayMap	display.

Choose	which	Method	you	want	to	use
There	are	3	ways	you	can	play	chords:	KeyboardMode,	ChordMode,
and	the	KBChord	SwitchKey.	These	are	explained	below.
Whichever	method	you	choose	to	use,	you	should	click	the	Play	Midi
Button	on	the	PlayMap	to	start	playing	the	MidiFile,	or	the	Play	Audio
Button	to	start	playing	a	synchronised	audio	file.	You	can	then	use	the
midi	keyboard	to	play	along	to	it.

Play	Chords	using	KeyboardMode
With	KeyboardMode,	the	pitches	that	would	normally	play	on	a	midi
keyboard	are	played,	subject	to	any	transposition	that	may	be	set.

Play	Chords	using	ChordMode
With	ChordMode,	the	white	notes	of	the	keyboard	are	mapped	to	the
current	chord	notes.	This	is	easier	to	play,	but	does	not	allow	non-chord
notes	to	be	played.
The	current	chord	changes	as	the	MidiFile	is	played.	If	a	null	chord	is



found,	it	will	play	the	previous	chord	(if	present).
If	the	first	chord	in	the	ChordFile	is	a	null,	nothing	will	sound	until	a	non-
null	chord	is	reached.

Play	Chords	using	KBChord	SwitchKey
Set	the	Mode	to	Keyboard	Mode.	Then	go	to	the	PlayMap	Menu	>
Configure	>	SwitchKeys/Pedal.
This	will	open	up	the	SwitchKeys	window.	Here,	you	can	select	the
dropdown	menu	KBChord	and	set	it	to	a	SwitchKey	or	sustain	pedal.
SwitchKeys	are	actioned	from	the	bottom	octave	of	your	Midi	keyboard,
or	the	sustain	pedal.
When	the	SwitchKey	or	sustain	pedal	is	pressed	down,	your	Midi
keyboard	will	play	the	nearest	chord	note	to	the	note	played.	If	you	are
already	playing	the	nearest	chord	note,	it	will	play	the	next	one	up	or
down.
You	can	play	block	chords	or	arpeggios.	However,	if	you	play	an
arpeggio,	you	should	keep	the	midi	keys	pressed	down	until	you	have
finished	playing	the	chord.
This	will	allow	you	to	play	chords	when	the	SwitchKey	is	down,	or	non-
chord	notes	when	it	is	up.
The	current	chord	changes	as	the	MidiFile	is	played.	If	a	null	chord	is
found,	it	will	play	the	previous	chord	(if	present).
If	the	first	chord	in	the	ChordFile	is	a	null,	it	will	play	the	keyboard	notes
without	change.



How	To	Improvise	a	Melody	along	with	a	MidiFile
The	main	idea	here	is	to	improvise	a	melody	using	the	chords	generated
(or	inputted)	into	this	application.
The	PlayMap	makes	this	easier	by	displaying	the	chords,	with	note
names	or	sol-fa	notation,	in	a	horizontal	Midi	Keyboard	display.	With
practice,	you	can	improve	your	improvisation	skills	by	playing	the	chord
notes	and	passing	notes	in	different	ways.
If	you	haven't	already	done	so,	load	a	Project	containing	a	MidiFile	and	a
ChordFile
(See	How	to	Generate	Chords	from	a	MidiFile	or	How	To	Insert	Keys
and	Chords	from	An	External	Source	to	find	out	how	to	create	a
ChordFile.)

Open	The	PlayMap
The	PlayMap	shows	the	current	position	in	the	MidiFile	in	a	display	that
shows	the	generated	chords	rolling	downwards	as	the	music	progresses.
This	makes	it	easier	to	improvise	and	play	along	with	the	MidiFile.
If	possible,	you	should	try	to	locate	your	keyboard	below	your	computer
screen,	and	resize	the	PlayMap	so	that	your	keyboard	keys	match	the
PlayMap	display.

Select	a	Play	Mode
There	are	two	play	modes	available	KeyboardMode	and	ChordMode	.
These	can	be	selected	using	the	option	buttons	on	the	left-hand	side	of
the	PlayMap,	or	from	a	SwitchKey.
In	both	cases,	the	PlayMap	will	display	the	notes	matching	the	pitches
that	will	be	played	by	the	appropriate	key	on	the	Midi	keyboard.

Keyboard	Mode
With	Keyboard	Mode,	the	normal	pitch	from	the	Midi	keyboard	(subject
to	any	transposition	or	octave	shifting	that	you	may	have	set)	will	be
played.	This	gives	you	the	freedom	to	play	any	notes,	using	the	PlayMap



as	a	guide.
Notes	of	the	scale	of	the	current	key	are	shown	on	the	bottom	line.	Chord
notes	are	shown	in	a	different	colour	on	the	lines	above.

Chord	Mode
With	ChordMode,	only	the	notes	of	the	current	chord	on	the	white	keys
are	played.	This	is	easier	to	play,	but	does	not	allow	non-chord	notes	to
be	played



How	To	Choose	a	Type	of	Audio	Synchronisation
Instead	of	playing	to	a	MidiFile,	you	can	play	to	an	audio	source,	which
can	be	either	an	AudioFile	(e.g.	MP3)	or	a	live	stream.
In	order	to	do	this,	you	have	to	synchronize	the	midi	data	(chords)	with
the	audio	source.	This	can	be	done	before	playing	the	audio	source	(file
synchronisation),	or	whilst	it	is	being	played	(live	synchronisation).
You	can	then	play	to	the	audio	source	in	the	same	way	as	you	would	play
to	a	MidiFile.

Choosing	File	Synchronisation
File	Synchronisation	is	easier	to	set	up	and	use,	and	is	the	preferred
method	by	default.
The	AudioFile	is	played	by	this	program,	and	synchronisation	is
performed	using	the	actual	position	in	the	file	(bytes).

Choosing	Live	Synchronisation
If	you	want	to	play	to	a	live	source,	or	a	source	that	cannot	be
reproduced,	you	can	use	live	synchronization.
This	requires	you	to	synchronize	the	midi	data	(chords)	whilst	the	audio	is
being	played.

See	also:

How	To	Sync	to	an	AudioFile

How	To	Play	Along	with	Live	Audio

How	To	Play	Along	with	an	AudioFile



How	To	Sync	to	an	AudioFile
This	explains	how	to	sync	to	an	AudioFile	that	will	be	played	by	this
program.

Load	a	Project
This	should	contain	at	least	a	ChordFile	(*.chp)	and	an	AudioFile	(
*.mp1,	*.mp2,	*.mp3,	*.wav,	*.riff,	*.aiff,	or	*.ogg).
The	AudioFile	should	be	an	approximate	match	to	the	ChordFile.	This
means	it	should	have	the	same	rhythm	and	structure,	but	doesn't	need	to
be	in	the	same	key.
The	ChordFile	can	be	created	from	a	MidiFile	(see	How	To	Generate
Chords	from	a	MidiFile),	or	an	external	source	(see	How	To	Insert
Chords	from	an	External	Source.

Setup	the	Sync	SwitchKey
Goto	PlayMap	Menu	>	Configure	>	SwitchKeys/Pedal.
Set	the	Sync	dropdown	box	to	a	SwitchKey	or	Pedal.

Position	the	ChordFile	to	a	Cue	Point
You	can	use	the	TrackMap	or	ChordMap	to	do	this.	However,	you	will
need	to	cue	to	somewhere	you	will	recognise	in	the	song	(e.g.	when	a
solo	or	vocal	starts)	that	is	on	a	barline.
If	you	have	created	a	lyric	file	(*.chl),	you	can	use	the	TrackMap	or
ChordMap	to	show	the	lyrics,	and	use	them	to	help	find	a	good	cue
point.
Otherwise,	it's	usually	easier	to	use	a	solo	track	on	the	TrackMap	to	find
a	cue	point.
Set	the	current	cursor	(vertical	bar)	in	the	TrackMap	(click	in	any	Track
pane)	or	ChordMap	(click	in	body	of	Midi	pane)	to	wherever	you	want
the	song	to	start	playing	(usually	at	the	start).	The	bar	will	be	highlighted
in	red.



Click	inside	the	Bar	Pane	of	the	TrackMap	or	ChordMap	with	the	left
mouse	button	to	set	the	cue	position.	This	is	where	you	will	start
synchronising	from.	This	must	be	somewhere	after	where	you	set	the
song	to	start	playing	from.

Sync	to	the	AudioFile
Click	the	Record	Audio	Button	on	the	TrackMap	or	ChordMap	to	start
playing	the	AudioFile.	Then	hit	the	Sync	SwitchKey	(or	Pedal)	when	the
cue	point	is	reached.
Continue	to	hit	the	key	on	every	beat	until	the	end.
Hit	the	Stop	Play	Button	to	end	the	sync.
The	sync	data	will	be	saved	in	the	AudioSync	Record	Track.	The	Play
Track	will	not	be	updated	until	you	use	Copy	or	Merge	from	the
AudioSync	window.

Save	the	Sync	Data
The	AudioSync	Record	Track	contains	the	last	sync	that	you	recorded.
If	you	want	to	save	or	play	this,	you	will	need	to	merge	or	copy	it	into	the
AudioSync	Play	Track.
Open	the	AudioSync	window	from	PlayMap	Menu	>	File	>	Show
AudioSync	Window
Click	the	Merge	Record	To	Play	Button.	If	you	get	an	error	message,	it
means	you	are	trying	to	merge	data	that	is	not	in	sequence.	You	will	have
to	either	use	Copy	Record	To	Play	or	re-record	the	sync	data.
You	can	the	use	the	Save	Play	to	File	Button	to	save	the	sync	data	to	a
.chtc	file.

Partial	Synchronisation
If	you	want	to	synchronise	from	somewhere	other	than	the	start	(e.g.	to
correct	a	mistake,	or	continue	from	where	you	left	off),	you	can	set	the
current	cursor	on	the	TrackMap	or	ChordMap	to	a	bar	that	has	alreay
been	synchronised.	You	should	then	set	the	Bar	Pane	cursor	(left	mouse
button)	to	somewhere	after	this,	but	in	a	region	that	has	still	been



synchronised.	Then	click	the	P	&	R	Audio	Button	on	the	TrackMap	or
ChordMap.
This	will	start	playing	from	the	current	cursor	position,	but	pause	when
you	reach	the	Bar	Pane	cursor	to	allow	you	to	use	the	synchronize	switch
key	to	start	synchronising.

Bar	Pane	Cursors
This	is	normally	set	by	clicking	the	left	mouse	button	over	the	Bar	Pane
in	the	TrackMap	or	ChordMap.	However,	you	can	also	use	the	right
mouse	button	to	set	a	different	cursor.
If	set,	this	will	be	used	to	set	the	set	the	position	in	the	MidiFile	after
hitting	the	Sync	Switchkey	during	playing	with	P	&	R	Audio.	This	has
the	effect	of	jumping	the	MidiFile	posiion	during	audio	play.	This	is	useful
if	there	are	bars	in	the	MidiFile	that	are	not	present	in	the	AudioFile.



How	To	Play	along	with	an	AudioFile	or	Stream
You	can	play	along	to	an	AudioFile	(MP3	etc)	in	a	similar	way	to	a
MidiFile,	but	with	some	important	differences:

You	can't	create	a	ChordFile	directly	from	an	AudioFile	-	you	will	need	to
do	this	from	a	MidiFile	that	approximately	matches	the	AudioFile,	or
from	an	external	source	(e.g.	sheet	music).

You	can't	mute	tracks	as	you	can	with	a	MidiFile.	However,	you	may	be
able	to	download	backing	tracks	that	usually	allow	you	to	mute	or	solo
audio	tracks.

You	will	need	to	synchronize	the	midi	data	(chords)	to	the	AudioFile
using	the	synchronisation	function,	or	synchronise	as	you	play	along.

Choose	a	Synchronisation	Method
You	can	synchronise	to	the	audio	stream	in	one	of	two	ways:

File	Synchronisation

Live	Synchronisation

Use	How	to	Choose	a	type	of	Audio	Synchronisation	to	choose
between	the	two	methods	above.
If	you	choose	Live	Synchronisation,	you	should	go	to	the	How	To	Play
along	to	Live	Audio.
Otherwise,	you	will	need	to	create	a	sync	file	using	How	to	Sync	to	an
Audio	File,	and	then	follow	the	steps	below.

Setup	the	Sync	SwitchKey
Go	to	PlayMap	Menu	>	Configure	>	SwitchKeys/Pedal.
Set	the	Sync	dropdown	box	to	a	SwitchKey	or	Pedal.

Load	a	Project
This	should	contain	a	SyncFile	(*.chtc).	It	should	also	contain	a
ChordFile(*.chp)	if	you	want	to	play	chords.
After	loading	the	Project,	the	Play	Audio	Button	on	all	playable	windows
(TrackMap,	ChordMap	and	PlayMap)	will	be	activated	if	a	SyncFile	has
also	been	loaded.

Start	Sync	Play
Click	The	Play	Audio	Button	on	any	playable	window	(PlayMap,
TrackMap,	or	ChordMap).	The	AudioFile	should	start	playing	from	the
current	cursor	position	on	the	ChordMap	or	TrackMap.
(If	the	AudioSync	Window	is	open	and	the	option	to	Start	from	Position



Time	is	enabled	and	checked,	it	will	start	from	the	Time	on	the	Position
Slider.)
The	position	will	be	updated	on	all	visible	playable	windows	as	the
AudioFile	plays,	and	you	should	be	able	to	use	the	ChordMap	to	play
along	with	it	in	the	same	way	as	you	play	along	with	a	MidiFile.

Transposition	and	Tuning
If	the	ChordFile	is	in	a	different	key	to	the	Audio	File	or	Stream,	you	will
have	to	use	transposition	to	match	it.	One	way	to	do	this	is	to	set	the
KBPitch	on	the	PlayMap	to	the	number	of	semitones	to	match	the	audio
file.	You	can	also	use	the	transposition	functions	of	the	ChordMap	to
achieve	similar	results.
In	the	unlikely	event	that	the	Audio	File	or	Stream	is	not	tuned	to
standard	pitch,	you	may	have	to	alter	the	fine	tuning	using	the	Midi
Configuration	Window.	This	will	change	the	pitch	of	all	notes	played	on
the	keyboard	or	midistream	by	up	to	one	semitone.



How	To	Play	Along	with	Live	AudioYou	can	play	along	with	other	musicians	or	an	audio	stream	without
synchronising	the	midi	data	(chords)	beforehand.
You	can	either	use	the	Next	Beat/Next	Bar	SwitchKeys,	or	Manual
Chord	Sync	Positioning.
Whichever	method	you	intend	to	use,	it	will	help	if	you	can	keep	track	of
where	you	are	in	the	music	as	it	is	being	played.	This	can	be	achieved
either	by	showing	the	lyrics,	or	by	displaying	at	least	one	recognisable
midi	track	from	the	MidiFile.	You	should,	therefore,	ensure	the	PlayMap
menu	item:	Window	>	Map	is	checked.	This	will	show	the	lyrics	(if
present),	and	it	will	also	allow	you	to	display	at	least	one	recognisable
track	(by	selecting	a	track	in	the	Track	Selection	Window	on	the	upper
left	hand	corner.)	See	PlayMap	for	more	information.



Using	the	Next/Prev	Beat/Bar/Chord	SwitchKeys
With	the	Next	Beat,	Next	Bar,	or	Next	Chord	SwitchKeys,	you	will	need
to	hit	the	SwitchKey	as	each	bar,	beat,	or	chord	is	reached.
It	is	usually	preferable	to	use	just	one	of	these	SwitchKeys,	depending	on
your	personal	preference.	The	Next	Beat	SwitchKey	is	the	easiest	to
use,	but	can	get	a	bit	tiring	after	a	while.	This	is	similar	to	synchronising
an	audio	file	(see	How	to	Sync	to	an	AudioFile),	except	you	will	be
synchronising	as	you	play	the	chords.
The	Next	Bar	SwitchKey	is	only	really	useful	if	all	chords	are	aligned	to	a
bar.
The	Next	Chord	SwitchKey	is	probably	the	most	useful,	as	long	as	you
remember	to	hit	the	SwitchKey	each	time	a	chord	is	reached	(even	if	you
don't	actually	play	it.)
All	of	the	SwitchKeys	work	on	the	same	principle	-	you	hit	the	SwitchKey
to	move	on	to	the	next	beat/bar/chord.	However,	you	can	play	the	next
chord	just	before	or	after	hitting	the	SwitchKey	if	it	coincides	with	the
SwitchKey.	This	is	because	the	SwitchKey	will	be	set	up	to	play	the	next
chord	when	the	previous	SwitchKey	is	released.	The	display	will	change
when	the	SwitchKey	is	played.	This	might	sound	a	bit	complicated,	but	it
seems	to	work	quite	well	in	practice,	as	long	as	you	keep	the	SwitchKey
pressed	down	until	just	before	the	next	MidiKey	is	played.

Setup	Next	Bar/Beat/Chord	Sync
The	ManSync	Chord	Positioning	CheckBox	should	be	unchecked	to
ensure	you	are	using	the	Next	Bar/Beat/Chord	SwitchKeys.

Setup	the	SwitchKeys
Go	to	PlayMap	Menu	>	Configure	>	SwitchKeys/Pedal.
Set	the	Next	Beat,	Next	Bar,	or	Next	Chord	dropdown	box	to	a
SwitchKey	or	Pedal.	It	is	recommended	to	use	only	one	of	these
SwitchKeys	at	a	time.
Optionally,	you	can	set	the	Prev	Beat,	Prev	Bar,	or	Prev	Chord



dropdown	boxes	to	another	SwitchKey	or	Pedal.

Load	a	Project	and	Play
You	will	need	to	load	a	Project	containing	a	ChordFile	that	matches	the
audio	that	you	want	to	play	along	to.
You	should	then	set	the	current	cursor	to	where	you	want	to	start	playing
from.	If	you	are	playing	an	audio	file	using	the	Play	Audio	NoSyn
Button,	it	will	start	playing	at	the	start	unless	you	have	set	another	start
position	from	the	AudioSync	Configuration	Window.
Once	the	audio	source	has	started	playing,	you	should	wait	for	it	to	reach
the	cue	point,	and	then	hit	the	Next	Beat	(or	Next	Bar)	SwitchKey.
You	can	now	play	the	first	chord	from	the	cue	point.
Continue	hitting	the	SwitchKey	when	the	next	beat/bar/chord	is	reached,
whilst	playing	the	chords.
Chords	are	normally	aligned	to	a	beat,	which	will	coincide	with	a
SwitchKey.	However,	it	doesn't	matter	if	the	chord	is	played	just	before
or	after	the	SwitchKey,	as	it	will	be	ready	to	locate	to	the	chord	after	the
previous	SwitchKey	is	released.	If	you	are	playing	a	slow	song,	or	using
the	Next	Bar	or	Next	Chord	SwitchKey,	make	sure	you	don't	release	the
SwitchKey	too	early!
If	you	lose	your	position	in	the	song,	you	should	try	to	go	forward	quickly
to	a	point	in	the	music	you	can	recognise,	and	wait	to	start	playing	again.
If	you	need	to	go	backwards,	you	can	either	wait	for	the	music	to	catch
up,	or	use	a	Prev	SwitchKey	to	to	get	back	to	the	current	position.



Using	Manual	Chord	Positioning	Without	SwitchKeys
This	allows	you	to	move	to	the	next	chord	when	required	without	using	a
SwitchKey.	It	takes	more	time	to	setup	and	get	used	to,	but	it	allows	you
to	play	the	chords	with	one	hand	only.	It	works	best	when	you	want	to
play	block	chords	to	accompany	the	music	with.
It	is	configured	using	the	Manual	Chord	Sync	window.
The	recommended	settings	on	the	Manual	Chord	Sync	Window	are:

Single	Black	Key:	Next	Chord

Single	White	Key:	No	Action

Next	Chord	if	All	Black:	Unchecked

Next	Chord	if	All	White:	Checked

Set	ManSync	Chord	Positioning

The	ManSync	Chord	Positioning	CheckBox	should	be	checked	to
ensure	you	are	using	chord	positioning	(as	opposed	to	Next	Bar/Next
Beat	SwitchKeys).

Set	KBChord	Mode

These	settings	will	be	set	automatically	if	the	ManSync	Bar/Beat
CheckBox	is	changed	from	checked	to	unchecked	on	the
Miscellaneous	Configuration	Window.
In	order	to	use	manual	chord	positioning,	you	should	set	the	Play	Mode
to	Keyboard,	and	the	KBChord	Checkbox	should	be	checked.	These
are	present	in	the	PlayMap	Controls	Window.	(KBChord	can	also	be	set
with	a	SwitchKey.)	The	PlayNotes	per	Chord	CheckBox	in	the
Miscellaneous	Configuration	Window	should	be	left	unset.

Load	a	Project	and	Play
You	will	need	to	load	a	Project	containing	a	ChordFile	that	matches	the
audio	that	you	want	to	play	along	to.
You	should	then	set	the	current	cursor	to	the	cue	point	where	you	want	to
start	playing	from.	This	should	be	at	the	start	of	a	non-null	chord.	If	you
are	playing	an	audio	file	using	the	Play	Audio	NoSyn	Button,	it	will	start
playing	at	the	start	unless	you	have	set	another	start	position	from	the
AudioSync	Configuration	Window.



Once	the	audio	source	has	started	playing,	you	should	wait	for	it	to	reach
the	cue	point,	and	then	play	the	chord	exclusively	using	the	white	notes
or	black	notes	of	the	keyboard.	The	position	will	move	on	to	the	next
chord	if	white	notes	are	played,	and	the	option	Next	Chord	is	All	White
is	checked,	or	if	all	black	notes	are	played,	and	the	option	Next	Chord	is
All	Black	is	checked.	The	first	chord	should	be	played	with	a
combination	of	notes	that	does	not	involve	repositioning.
if	you	want	to	reposition	without	playing	a	chord,	use	a	single	key.	It	will
perform	the	action	set	according	to	the	option	selected	in	the	Single
Black	Key	or	Single	White	Key	options	in	the	Manual	Chord	Sync
Window.
Any	null	chords	are	skipped	over	during	repositioning.

Experiment	with	Different	Options
There	are	a	number	of	options	on	the	Manual	Chord	Sync	Window	that
you	can	try	out.	However,	some	combinations	of	options	don't	really
make	sense.	The	most	useable	options	you	can	try	out	are:

Single	Black	Key:	Next	Chord

Single	White	Key:	No	Action

Next	Chord	if	All	Black:	Unchecked

Next	Chord	if	All	White:	Checked

Single	Black	Key:	Next	Chord

Single	White	Key:	No	Action

Next	Chord	if	All	Black:	Checked

Next	Chord	if	All	White:	unchecked

Single	Black	Key:	No	Action

Single	White	Key:	Next	Chord

Next	Chord	if	All	Black:	Unchecked

Next	Chord	if	All	White:	Checked

Single	Black	Key:	Previous	Chord

Single	White	Key:	Next	Chord

Next	Chord	if	All	Black:	Unchecked

Next	Chord	if	All	White:	Checked



Configure	Midi	Devices
This	is	used	to	configure	Midi	Input	and	Output	devices
There	are	three	devices	that	can	be	configured	here:

Midi	Keyboard	(input)

Sequencer	Stream	(output)

Midi	Keyboard	(output)

The	Midi	Keyboard	input	device	should	be	set	to	your	midi	keyboard
The	output	devices	can	be	set	to	a	Midi	Synthesizer	that	is	external	to
this	application,	or	to	the	Built_In	synthesizer	that	is	provided	by	this
application.
If	you	set	the	output	devices	to	the	same	external	synthesizer,	you	will
have	to	ensure	that	any	midi	keyboard	output	is	set	to	a	midi	channel	not
used	by	the	output	stream.	If	you	set	the	output	devices	to	the	built-in
synthesizer,	they	will	use	different	ports,	so	all	channels	can	be	used	on
both	devices.
The	synth	packaged	with	Windows	(Microsoft	GS	Wavetable	Synth	or
similar)	is	not	recommended.	This	is	poor	quality,	and	introduces	a
latency	(delay)	that	will	be	noticeable	even	if	the	sound	card	delay	is
small.
If	you	use	the	Built_In	Synth,	and	the	audiocard	is	connected,	a	panel	will
be	displayed	to	allow	the	soundfont,	volume,	tuning	and	FX	effects	to	be
set.
The	soundfont	dropdown	list	shows	all	the	soundfont	files	found	in	the
soundfonts	path.	The	list	can	be	changed	using	PlayMap	Menu	>
Configure	>	Paths	>	SoundFonts.	You	will	need	to	redisplay	the	Midi
Config	window	for	the	update	to	take	effect.
The	selected	soundfont	will	be	loaded	on	Connect/Reconnect.	If	there
are	no	soundfont	files	found,	you	will	be	prompted	to	select	a	new
soundfonts	path.
Changes	will	be	actioned	after	the	Connect/Reconnect	button	is	clicked,
and	will	be	saved	using	the	PlayMap	Menu	>	File	>	Save	Settings,	or
clicking	Save	Settings	and	Exit	Program	option	when	exiting	the
application.
A	description	of	the	controls	used	in	the	Midi	Devices	Configuration
Window	can	be	found	here.
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